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Parallel Geoscience Corporation

Providing State-of-the-Art Seismic Data Solutions since 1988

Welcome to the Seismic Processing Workshop (SPW) system. SPW is a suite of applications written by Parallel Geoscience Corporation for processing seismic and/or GPR data. The SPW system was originally written for the Macintosh computer platform and has been redesigned and rewritten using a cross platform framework. SPW is currently available for Windows 2000/XP, Macintosh, and Linux operating systems. The SPW system is composed of the following applications – SPW I/O Utility, SeisViewer, Vector Calculator, FlowChart and Executor. Each of these applications is also available separately.

Our goal is to provide quality products at affordable prices with exceptional support.  We have therefore designed our seismic processing software to be simple, affordable and dependable.  Our Seismic Processing Workshop (SPW) is easy to use and easy to train others to use, featuring a point-and-click graphical user interface, smart spreadsheets, data entry dialog boxes, and a flexible flowchart interface.  Now you can have Unix performance with PC prices, with purchasing, replacement parts and service available worldwide.  SPW embodies proven technology for both field and office.  In most cases, we provide a one-business-day response to most of the problems you face with our internet based support system.  We also provide frequent updates and additions.  SPW is simple, affordable and dependable.

SPW requirements

Memory

Minimum of 128 MB

Recommend 256 megabytes or more

Disk space

Minimum of 10 GB

Recommend 30 gigabytes or more

Space in bytes = shots * channels * samples/trace *

4 bytes/sample

SPW Components
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About This Manual

This manual is organized around the main features of the five modules in the SPW application.  These features will be explained and illustrated in terms of the most commonly performed tasks.  

Parallel Geoscience Corporation

37 Ocean Dr.

MacMasters Beach 2251

N.S.W., Australia
Tel: +61 2 4381-2483
E-mail: support@ parallelgeo.com

Web: http://www.parallelgeo.com

SPW, Seismic Processing Workshop, SPW I/O Utility are trademarks of Parallel Geoscience Corp.

© 2007 Parallel Geoscience Corporation
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Seismic Processing Workshop
The SPW software installer will place a shortcut on the desktop labeled SPW. From this shortcut you can access all the application in the Seismic Processing Workshop.  Double-clicking on the SPW shortcut will open the window seen below:
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A single click on any of the five icons will launch the corresponding SPW application.

I/O Utility
I/O Utility is an interactive, window-oriented, menu driven application.  It has six main features, which may be accessed upon opening the application.  These features are 1) Tape Analysis, 2) File Analysis, 3) Data Reformat, 4) Tape Image Copy, 5) SPW File Merge and 6) Tape Image Verify.  A seventh feature, Create File Index, will be used in future versions of SPW for processing of SEGY data.
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User Interface at Startup

Tape Analysis

The Tape Analysis utility is designed for the efficient analysis of tapes whose content is unknown or problematic. To use the Tape Analysis utility, simply click on the Tape Analysis button in the Main Window and the Tape Analysis window will appear. 
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Main Window
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Tape Analysis Window

The remainder of the chapter will: (1) discuss the various features of the Tape Analysis window; (2) explain the number systems that the Tape Analysis utility is capable of interpreting; and (3) provide examples of the analysis of actual SEG-Y and SEG-D data files to determine the parameters necessary to reformat those files to SPW format.

Tape Analysis Window
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The Tape Analysis Window.

Dialog Parameters
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Select drive… The Select drive button opens the Input Tape Select dialog, which allows you to select an external tape drive that contains a physical tape with data to be analyzed.  Once a drive has been selected, the name of the drive will appear beneath the Select drive… button.

No rewind on close – The input tape will not be rewound at the end of the tape analysis session.

Unload on EOT – The tape automatically rewinds and unloads when the end of tape marker is found.

Auto-loader – Indicates that an auto-loader will be used to load multiple input tapes.

M4 mode – For use with an M4 tape drive.

Dump Format – A drop down menu is used to select the format in which the selected data will be dumped into the Tape dump window.  Dump formats include Hexadecimal, ASCII, EBCDIC, Short Integer, Long Integer, IBM Float, and IEEE Float. 

Show dump window - The Show dump window button is a toggle that allows the dump window to be displayed or hidden.  When the Show dump window button is clicked, the Tape dump window appears and the button toggles to the Hide dump window button.

Refresh dump – The Refresh button is used to redump the same block of data after changing the dump format.  This allows you to analyze the same block of data in several formats without returning repeatedly to the same starting block.

Tape Control – The Tape Control commands are used to control the position of the Tape Analysis utility and read data from the currently selected tape.

Read  >
Clicking the Read button cause the number of blocks entered in the Read parameter field to be dumped to the Tape dump window. The dump starts at the first byte of the current block.

Skip  <<  >>
Clicking the Skip button advance or reverses the current position of the Tape Analysis utility by the number of blocks entered in the Skip parameter field.

Start byte for display – Indicates the byte position in the current block from which the Tape Analysis utility will dump data for display.

Bytes to display - Indicates the maximum number of bytes that will be displayed in the Tape Dump Window from the blocks selected for a tape dump.  This value may be greater than or less than the actually number of bytes contained in the blocks.

Data Byte Order


Big endian – If checked, the Tape Analysis utility will read integer values in big endian byte order.  In big endian byte order the most significant byte of the integer value is stored in the first, or lowest data address. 


Little endian - If checked, the Tape Analysis utility will read integer values in little endian byte order.  In little endian byte order the least significant byte of the integer value is stored in the first, or lowest data address.

For example, the 4-byte big endian integer representation of the decimal value 2049 (211 +1) is:

00000000 00000000 00001000 00000001


When written as a sequence of 1-byte (8-bit) entries, the big- and little-endian representations of this number are as follows:

	Byte
	Big-endian
	Little-endian

	0
	00000000
	00000001

	1
	00000000
	00001000

	2
	00001000
	00000000

	3
	00000001
	00000000


Integer Sign


Signed – If checked, integer values will be read as signed, implying that when the value was written to tape a sign bit was coded.  


Unsigned - If checked, integer values will be read as unsigned, implying that when the value was written to tape a sign bit was not coded.  

For example, a signed Short Integer (2-bytes) will use 1 bit for a sign bit and 15 bits to store the sample value.  Therefore, the possible range of data values is –215 to 215-1, or –32,768 to 32,767.  An unsigned Short Integer (2-bytes) will use all 16 bits to store the sample value.  Therefore, the possible range of data values is 0 to 216-1, or 65,535.

Tape Read Mode  - The tape read mode options are not applicable on Windows and Linux operating systems.


Short Block – To be used if the SCSI device reads in data blocks less than or equal to 64kb.  This is the case with Mac OS X.


Long Block – To be used if the SCSI device reads in data blocks larger than 64kb.  This is only an issue on the older Mac OS (pre OS X). 

Note on Number Systems

The Tape Analysis utility is designed to dump binary information coded into a files byte structure in the following formats:


Hexadecimal


ASCII


EBCDIC


Short Integer



Long Integer


IBM Float


IEEE Float

The hexadecimal number system is used to compactly represent binary numbers.  ASCII and EBCDIC are codes for representing English characters as numbers on a computer.  Integer numbers are whole numbers that do not contain a fractional part.  Floating-point numbers are real numbers that contain a fractional part.  Floating-point numbers are always expressed as 

Floating point number = (sign)*(fraction)*(base exponent-bias).

Each of these variable types will be discussed briefly.

Hexadecimal – 
The hexadecimal number system is a base 16 system that uses the values 0-9 and A-F to represent decimal numbers.  Hexadecimal values are often display with the suffix “H”, such a 33a5H for the value 33a5.  The following chart displays the conversion between decimal, binary, and hexadecimal.

	Decimal
	Binary
	Hexadecimal

	0
	0000
	00H

	1
	0001
	01H

	2
	0010
	02H

	3
	0011
	03H

	4
	0100
	04H

	5
	0101
	05H

	6
	0110
	06H

	7
	0111
	07H

	8
	1000
	08H

	9
	1001
	09H

	10
	1010
	0AH

	11
	1011
	0BH

	12
	1100
	0CH

	13
	1101
	0DH

	14
	1110
	0EH

	15
	1111
	0FH

	16
	1000
	10H


Decimal-binary-hexadecimal conversion chart.

ASCII – 
ASCII is shorthand for American Standard Code for Information Interchange.  The ASCII code was designed to represent English characters as numbers on a computer.  In modern usage, ASCII is a byword for raw, text-only files.

EBCDIC – 
EBCDIC is shorthand for Extended Binary Coded Decimal Interchange Code.  The EBCDIC code was designed by IBM to represent English characters as numbers on a computer.  The EBCDIC code is used to store information in the SEG Y reel header.

Short Integers – 
A two-byte integer value that may be signed or unsigned.  If signed, 1 bit is allocated for a sign bit and 15 bits are allocated to store the sample value.  Therefore, the possible range of data values for a signed Short Integer is –215 to 215-1, or –32,768 to 32,767.  If unsigned, all 16 bits are allocated to store the sample value.  Therefore, the possible range of data values for an unsigned Short Integer is 0 to 216 – 1, or 0 to 65,535.

Long Integers – 
A four-byte integer value that may be signed or unsigned.  If signed, 1 bit is allocated for a sign bit and 31 bits are allocated to store the sample value.  Therefore, the possible range of data values for a signed Long Integer is –231 to 231-1, or –2,147,483,648 to 2,147,483,647.  If unsigned, all 32 bits are allocated to store the sample value.  Therefore, the possible range of data values for an unsigned Long Integer is 0 to 232-1, or 4,294,967,296.

IBM Float – 
A floating point format in which contains 1 sign bit, 7 bits for the exponent, and 24 bits for the fraction.

IEEE Float – 
A floating point format in which contains 1 sign bit, 8 bits for the exponent, and 23 bits for the fraction.

Example:
SEG-Y Format

The SEG-Y format is a demultiplexed seismic data format that consists of a 3600-byte reel identification header followed by trace data blocks (fig.1).  The reel identification header consists of a 3200-byte EBCDIC (Extended Binary Coded Decimal Interchange Code) text file header and a 400-byte binary file header.  Each of these two blocks contains information specific to the seismic data in the Tape File.  The trace data block consists of a 240-byte binary coded trace identification header followed by the trace data samples. There is one trace identification header per trace.  For more information concerning the SEG-Y Format standard, consult the SEG digital tape standards at 

http://seg.org/publications/tech-stand/

To analyze a SEGY tape file, use the Select drive… button in the Tape Analysis window to open the Input Tape Select dialog. The Input Tape Select dialog is used to select an external tape drive that contains a physical tape with SEG-Y data to be analyzed.  Once the desired tape drive has been selected, click on the OK button in the upper right corner of the Input Tape Select dialog.  The Tape Analysis window will display the name of this tape drive directly beneath the Select drive… button.
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Figure 1.  Schematic representation of a SEG-Y file.
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Input Tape Select Dialog

[image: image171.png]SPW Tape Utility
Fie Edt Control Window Help

52

1/0 will be limited to 512k byres per block

fopenea £i1e 101003 sqa.
lnesa 22 bytes

Revound file

Resa 142 bytes

SPW Tape Utility

Tape Analysis | File Analysis |

Data Reformat | Tape Image Copy |

SPW File Merge | Tape Image Verify |

File Analysis Window

Select Hide Dump Window |

101003.5gd

Dump format [Hexadecimal ~ ~.

File Control

Read 148
Seek <<| >

Gotobyte | [1
Go to start

Refresh
Save

[n) bytes. ~Data Byte Order—
& Big endian

€ Little endian

—

[Integer Sign
& Signed
€ Unsigned

SPWReports |

[Trace Kills Report
4D Converter Test
Crossfeed Test
THD Test

EIN Test

Select

Byte position in file
148

File size in bytes
1155008

Close |

[ File Dump Window

Ee£ze056 00000000 00000310 99112546 00000000 00000200 O0SEEZOL 02000000
01228500 00000000 00000100 00000003 £2000200 00000000 00000000 c3195233
01010000 01£40000 01442003 10000024 00000000 00000000 00000000 00010000
01020000 01£40000 00007003 10000024 00000000 00000000 00000000 00010000

jooooo
Jooos2
Joooss
loooss
ooz2e

££££0101 00010000 00000000 00000000 000Leath





Tape drive containing a SEG-Y tape file has been selected for analysis. 

A great deal of information can be extracted from a properly written SEG-Y reel header.  As stated above, the reel header consists of a 3200-byte EBCDIC text header and a 400-byte binary header. The SEG-Y EBCDIC reel header contains 40 lines of comment cards, at 80-bytes per line.  These comment cards are used to describe the contents of the SEG-Y.  To read the EBCDIC header, set the dump format to EBCDIC using the drop down menu, the Start byte for display to <0>, the number of Bytes to display to <3200>, and instruct the Tape Analysis utility to read the first block of data by entering <1> in the parameter field to the right of the Read button in the Tape Control submenu.  

Preparing to read a SEG-Y EBCDIC reel header.
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To dump the 3200-byte EBCDIC header to the File Dump Window, click on the 
READ > button in the Tape Control submenu.  The dump window will appear with the contents of the EBCDIC header.  In this case, the EBCDIC header was left blank.

The EBCDIC text header displayed in the Tape Dump Window. This particular tape file was created with a blank EBCDIC text header.

After dumping the EBCDIC text header to the Tape Dump Window, the Tape Analysis utility is positioned at byte 3200 (start of block 2) of the selected SEG-Y tape file, which is the correct position to read the 400-byte binary reel header.  To read the binary reel header, set the dump format to Short Integer, the Data Byte Order to Big Endian (or as appropriate), the Integer Sign to Unsigned, and instruct the Tape Analysis utility to read 1 block of data.  Click on the READ > button in the Tape [image: image174.png]Analysis Window.
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Control submenu to dump the binary reel header.

Preparing to read a SEG-Y binary reel header.
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The Binary reel header displayed in the Tape Dump Window.

The first 60-bytes of the SEG-Y binary reel header are assigned values that are described in the SEG-Y standard.  The remaining 340-bytes are left unassigned and may contain any information that the processor or acquisition contractor deems necessary.  The binary reel header displayed in the Tape Dump window in the figure above contains mandatory information regarding the seismic file:  (1) bytes 13-14 (bytes 3213-3214 in the file) indicate the number of data traces per record, in this case 52; (2) bytes 17-18 (bytes 3217-3218 in the file) indicate the sample rate in microseconds, in this case 2000; (3) bytes 21-22 (bytes 3221-3222 in the file) indicate the number of samples per data trace, in this case 3000; and (4) bytes 25-26 (bytes 3225-3226 in the file) indicate the data sample format code, in this case IBM floating point (1 = 4-byte IBM floating point).

After dumping the binary reel header to the Tape Dump Window, the Tape Analysis utility is positioned at byte 3600 (start of block 3) of the selected SEG-Y tape file, which is the correct position to read the 240-byte binary trace header corresponding to the first trace in the file.  To read the first binary trace header, set the dump format to Short Integer, the Data Byte Order to Big Endian (or as appropriate), the Integer Sign to Signed, and instruct the Tape Analysis utility to read 1 block and display 240-bytes.  The third block of data contains both the binary trace header and the corresponding data samples.  Therefore, if you choose to display more than 240-bytes, you will see IBM or IEEE floating point values interpreted as short integers.  These values will appear to be meaningless.  Click on the READ > button in the Tape Control submenu to dump the binary trace header.
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Preparing to read a SEG-Y binary trace header.
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The Binary trace header displayed in the Tape Dump Window.

All 240-bytes of the SEG-Y binary trace header are assigned values that are described in the SEG-Y standard.  The binary trace header displayed in the Tape Dump window in the figure above contains the trace information specific to the first data trace in the seismic file:  (1) bytes 1-4 (bytes 3601-3604 in the file) indicate the trace sequence number in the line, in this case 1; (2) bytes 9-12 (bytes 3609-3612 in the file) indicate the field record number, in this case 280;  (3) bytes 17-20 (bytes 3617-3620 in the file) would indicate the source point number, but are blank because we are analyzing raw field records; (4) bytes 21-24 (bytes 3621-3624 in the file) would indicate the CMP number of the data trace, but are blank because we are analyzing raw field records;  (5) bytes 29-30 (bytes 3629-3630 in the file) indicate the trace identification code, in this case 1 (1 = seismic);  (6) bytes 37-40 (bytes 3637-3640 in the file) would indicate the source-receiver offset, but are blank because we are analyzing raw field records.  A complete description of the SEGY standard is available from the Society of Exploration Geophysicists.

Although 240-bytes of data were dumped to the File Dump Window, both the Console window and the File Dump Window display messages indicating that block 3 contained 12,240 bytes.  The additional 12,000-bytes correspond to the trace data samples (3000 samples * 4 bytes/sample = 12,000 bytes).  We chose not to display this information because our initial interest was in the binary trace header.  To view the sample values corresponding to the first 40 samples of the data trace, change the Bytes to display value to 400 (240-bytes Trace Header + 40 samples * 4 bytes/sample = 400 bytes), set the dump format to IBM Float, the Data Byte order to Big endian (or as appropriate) and click on the refresh button to re-dump the data samples to the File Dump Window.
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Preparing to read a SEG-Y trace data block.
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The trace header and the first 40 samples of trace data corresponding to trace 1 of the tape data file.

At this point, we have determined that the mandatory header values of the SEG-Y tape  (number of traces per record, sample interval, samples per trace, format code, field file number, and trace number) are in the standard locations.  The tape file may be successfully reformatted using the SEG-Y default parameterizations provided with IO Utility. 

Example:
SEG-D Format

The SEG-D format is really a family of seismic data acquisition formats that may be used to record both multiplexed and demultiplexed data. The original SEG-D tape standard was published in 1975 (Geophysics, 40, no. 02, 344-352) and has been revised twice to keep up with changes in the seismic data acquisition environment (Geophysics, 59, no. 04, 668-684; Geophysics, 62, no. 03, 1004-1031).  

A basic SEG-D demultiplexed file format (fig. 2) consists of one or several 32-byte General Header blocks followed by one or several 32-byte Channel Set Descriptor blocks.  The General Header blocks contain information specific to the seismic data in the file and the acquisition hardware used to acquire that data.  An important aspect of the SEG-D family of formats is that SEG-D is self defining in the sense that information contained in the first General Header block specifies both the number of subsequent General Header blocks as well as the length of the data record. A Channel Set Descriptor block contains information specific to a single channel set, which is defined as a group of channels operating with identical recording parameters.  The General Header and Channel Set Descriptor blocks are followed by the Channel sets, which consist of a number of 20-byte trace headers with their associated trace data samples. The trace headers contain basic information, such as field file number and channel number, which are specific to their associated seismic trace.  There is one trace header per seismic data trace.  For more information concerning the SEG-D Format standards, consult the SEG digital tape standards at: 

http://seg.org/publications/tech-stand/

To analyze a SEG-D tape file, use the Select drive… button in the Tape Analysis window to open the Input Tape Select dialog. The Input Tape Select dialog is used to select an external tape drive that contains a physical tape with SEG-D data to be analyzed.  Once the desired tape drive has been selected, click on the OK button in the upper right corner of the Input Tape Select dialog.  The Tape Analysis window will display the name of the tape drive directly beneath the Select drive… button.
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Figure 2.  Schematic representation of a SEG-D file.

 Input Tape Select Dialog
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The tape drive containing a SEG-D tape file has been selected for analysis.

The SEG-D general header blocks contain information specific to their associated seismic data file, such as the field file number, the SEG-D format code, the time of shooting, the sampling interval, and the record length.  As stated above, a SEG-D demultiplexed file consists of one or several 32-byte General Header blocks followed by one or several 32-byte Channel Set Descriptor blocks.  The original SEG-D format had one general header block followed by one or several Channel Set Descriptor blocks. SEG-D revisions 1 and 2 contain a minimum of two general header blocks and allow for additional general header blocks should the need arise.  The number of additional general header blocks is indicated in General Header block #1.

All values in the general header blocks are written as packed binary coded decimal, unless otherwise specified.  To read the general header, set the dump format to Hexadecimal using the drop down menu, and instruct the Tape Analysis utility to display the first 32-bytes by entering <0> in the Start byte and <32> Bytes to display fields.  
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Preparing to read a the first SEG-D general header block.

To dump the currently selected 32-bytes of data to the Tape Dump Window, click on the READ > button in the Tape Control submenu.  The dump window will appear with the contents of the first 32-byte general header.
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The first general header block displayed in the Tape Dump Window.

Each of the eight-character strings in the dump represents 4-bytes of the file.  Eight strings equal 32-bytes.  The SEG-D format code, 8058, in bytes 3-4, indicates that this file was written in one of the revised SEG-D formats (i. e. revision 1 or 2).  SEG-D 8058 was not supported in the original SEG-D format description.  In SEG-D 8058 data samples are written to tape as 32-bit IEEE demultiplexed floating point values.   The file number (9000) is contained in bytes 1-2.  The last two digits of the year (97), the Julian day (252), the hour (09), the minute (04), and the second (52) at the time of recording are contained in byte 11, byte 12 bits 5-8 and byte 13, byte 14, byte 15, and byte 16, respectively.  The number of additional general header blocks (2) is contained in the first four bits of byte 12.  This means that there are three general header blocks in total.  The manufacturer code (Sercel) is contained in byte 17.  The sample interval (2 ms) is coded as a binary number in byte 23.  The ‘fff’ in byte 26 bits 5-8 and byte 27 indicates that the record length has been written in bytes 15-17 of general header block #2.  The scan types per record (1) and number of channel sets per scan type (16) are contained in byte 28 and byte 29, respectively.  Byte 30 indicates that there are no skew blocks.  Byte 31 indicates that there are 32 extended header blocks, each of which is 32-bytes long.  Byte 32 indicates that there are 32 external header blocks, each of which is 32-bytes long.  In summary, general header block #1 reveals that there are a total of three general header blocks 16 channel set descriptor blocks, 32 extended header blocks, and 32 external header blocks prior to the first 20-byte trace header block.  
Therefore, the complete file header will be (3 General Header Blocks) * (32 bytes/block) + (16 Channel Set Descriptor Blocks) * (32 bytes/block) + (32 extended header blocks) * (32 bytes/block) + (32 external header blocks) * 32 bytes/block = 2656 bytes.  This is confirmed by messages in both the Console and File Dump Window.

To dump the complete file header, just change the Bytes to display value to <2656> and refresh the dump.
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General header blocks 1, 2 and 3, and channel set descriptor blocks 1 through 16, and 24 of the external header blocks.  Only the first two channel set descriptor blocks contain useful information.   

The first 32 bytes of the dump are the contents of the first general header block.  The next 32 bytes are the contents of the second general header block, which contain the SEG-D revision number (1) in byte 11, the record length (3000 ms) as a hexadecimal value (0bb8) in bytes 15-17, and the general header block number (2) in byte 19.  Bytes 20-32 are not defined in revision 1 of the SEG-D format. The third line contains the contents of the third general header block, which contains the source point index (1) in byte 14, the general header block number (3) in byte 19, and the source set number (1) in byte 20.  The fourth and fifth lines in the Tape Dump Window display the contents of the first two Channel Set Descriptor blocks.   In each case the scan number is in byte 1 and the channel set is in byte 2.  The number of channels in the channel set is contained in bytes 9-10. The channel type indicator is in the first 4 bits of byte 11.  Channel set one consists of 3 auxiliary (9) channels and channel set two consists of 170 seismic (1) channels. The frequency of the anti-alias filter in Hertz and the roll-off of the filter in dB/octave are contained in bytes 13-14 and bytes 15-16, respectively.  In each case, the frequency of the anti-alias filter is 200 Hz and the roll-off is 370 dB/octave.  The value of 1 in byte 30 of the channel set descriptor blocks indicates that the traces are unstacked.

The Tape Analysis utility is currently positioned at byte 2656 (start of block 2) of the selected SEG-D tape file.  This is the starting point of the 20-byte trace descriptor block corresponding to the first trace.  To dump the trace header, set the dump format to Hexadecimal using the drop down menu, and instruct the Tape Analysis utility to display the first 20-bytes by entering <0> in the Start byte and <20> Bytes to display fields.  Click on the READ > button to display the contents of the first trace descriptor block.  
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The contents of the first trace descriptor block.

The 20-byte trace header contains the file number (9000) in bytes 1-2, scan number (1) in byte 3, the channel set (1) in byte 4, the trace number (1) in bytes 5-6, and the number of 32-byte trace header extensions (1) in byte 10.  To read the 32-byte trace header extension, just change the Bytes to display value to <52> (20-byte trace header block + 32-byte extension) and refresh the dump.
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The contents of the first trace descriptor block and the trace header extension.

The 32-byte trace header extension contains information regarding the receiver point number (1), the receiver point index (1), and most importantly the number of samples per data trace (1501) coded as hexadecimal in bytes 8-10 (05dd).  Therefore, the number of bytes in the second block – 6056 bytes – are in agreement with our analysis (20-byte Trace Descriptor Block + 32-byte Trace Header Extension + 1501 samples * 4 bytes/sample = 6056 bytes).  Bytes 11-32 of the trace header extension are undefined by format and may take on any value.

To view the first 40 sample values corresponding to the first data trace, change the Bytes to display value to 212 (20-bytes Trace Descriptor Block + 32-byte Trace Header Extension + 40 samples * 4 bytes/sample = 212 bytes), set the dump format to IEEE Float, the Data Byte order to Big endian (or as appropriate) and click on the refresh button to re-dump the data samples to the File Dump Window.

The 20-byte Trace Descriptor Block (as IEEE Floating-Point), the 32-byte Trace Header Extension (as IEEE Floating-Point), and the first 40 data samples from trace 1 of the first file. 
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At this point, we have determined that the mandatory header values of the SEG-D tape  (number of traces per record, sample interval, samples per trace, format code, field file number, and trace number) are in the standard locations.  The tape file may be successfully reformatted using the SEG-D default parameterizations provided with IO Utility.

File Analysis

The File Analysis utility is designed for the efficient analysis of disk files whose content is unknown or problematic. To use the file analysis utility, simply click on the File Analysis button in the Main Window and the File Analysis window will appear.  
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File Analysis Window

The remainder of the chapter will: (1) discuss the various features of the File Analysis window; (2) explain the number systems that the File Analysis utility is capable of interpreting; and (3) provide examples of the analysis of actual SEG-Y and SEG-D data files to determine the parameters necessary to reformat those files to SPW format.

File Analysis Window
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The File Analysis Window.

Dialog  Parameters
Select file… The Select file button opens the Open Input Disk File dialog, which allows you to maneuver through the directory structure and locate an input file for analysis.  Once a file has been selected, the file name will appear beneath the Select file… button.

Dump Format – A drop down menu is used to select the format in which the selected data will be dumped into the File dump window.  Dump formats include Hexadecimal, ASCII, EBCDIC, Short Integer, Long Integer, IBM Float, and IEEE Float. 

Show dump window - The Show dump window button is a toggle that allows the dump window to be displayed or hidden.  When the Show dump window button is clicked, the File dump window appears and the button toggles to the Hide dump window button.

Refresh – The Refresh button is used to redump the same block of data after changing the dump format.  This allows you to analyze the same block of data in several formats without returning repeatedly to the same starting byte.

Save – Allows the current contents of the File dump window to be saved as a text file.

File Control – The File Control commands are used to control the position of the File Analysis utility in the currently selected data file.

Read  >
Clicking the Read button cause the number of bytes entered in the Read parameter field to be dumped to the File dump window. The dump starts at the current byte position.

Seek <<>>Clicking the Seek button advance or reverses the current byte position of the File Analysis utility by the number of bytes entered in the Seek parameter field.

Go to byte
Clicking the Go to byte command positions the File Analysis utility at the byte position entered into the Go to byte field.

Go to start
Clicking the Go to start command positions the File Analysis utility at the first byte of the selected file.

Byte position in file – Indicates the byte position at which the File Analysis utility is currently located.

File size in bytes - Indicates the size of the currently selected file in bytes.

Data Byte Order


Big endian – If checked, the File Analysis utility will read integer values in big endian byte order.  In big endian byte order the most significant byte of the integer value is stored in the first, or lowest data address. 


Little endian - If checked, the File Analysis utility will read integer values in little endian byte order.  In little endian byte order the least significant byte of the integer value is stored in the first, or lowest data address.


For example, the 4-byte big endian integer representation of the decimal value 2049 (211 +1) is:

00000000 00000000 00001000 00000001

When displayed as a sequence of 1-byte (8-bit) entries, the big- and little-endian representations are as follows:

	Byte
	Big-endian
	Little-endian

	0
	00000000
	00000001

	1
	00000000
	00001000

	2
	00001000
	00000000

	3
	00000001
	00000000


Integer Sign


Signed – If checked, integer values will be read as signed, implying that when the value was written to the file a sign bit was coded.  


Unsigned - If checked, integer values will be read as unsigned, implying that when the value was written to the file a sign bit was not coded.  

For example, a signed Short Integer (2-bytes) will use 1 bit for a sign bit and 15 bits to store the sample value.  Therefore, the possible range of data values is –215 to 215-1, or –32,768 to 32,767.  An unsigned Short Integer (2-bytes) will use all 16 bits to store the sample value.  Therefore, the possible range of data values is 0 to 216-1, or 65,535.

SPW Reports – The SPW Reports dialog is used to generates diagnostic reports from SPW formatted data.  Reports can only be generated from SPW data.  Report formats include:


Trace Kills Report – The Trace Kills Report is used to generate a list of traces that have been killed (1) during application of the geometry; (2) by processing steps such as Kill Traces and Automatic Trace Edits; (3) interactively in SeisViewer.


A/D Converter Test – The A/D Converter test measures the accuracy of the recording instruments. 


Crossfeed Test – The Crossfeed test measures the amount of electrical interference that is present in each channel of the recording instrument due to a known signal driven on adjacent channels.  


THD Test – The Harmonic Distortion (HR) test measures the recording accuracy of the recording instrument as a function of frequency.


EIN Test – The Equivalent Input Noise (EIN) test measure the amount of noise generated by the electronic components of the recording instrument.


DC Offset Test – The DC Offset test measures the amount of DC bias (in microvolts) that is present in each channel of the recording instrument.


Dynamic Range Test – The Dynamic Range test measures the recording range of a signal input to the recording instrument above the noise level of the recording instrument.


Impulse Response Test – The Impulse Response test measures the impulse response of the recording system by sending a pulse through that system and recording the response.


Gain Accuracy Test – The Gain Accuracy test provides a measure of the accuracy of the amplifiers in the recording instrument.


Gain Step Test – The Gain Step test provides a measure of the accuracy of the amplifiers in the recording instrument.

For a complete discussion of each of the SPW Report types, consult the I/O Utility manual.

Note on Number Systems

The File Analysis utility is designed to dump binary information coded into the byte structure of a file in the following formats:


Hexadecimal


Long Integer
ASCII



Short Integer
EBCDIC


IBM Float
IEEE Float

The hexadecimal number system is used to compactly represent binary numbers.  ASCII and EBCDIC are codes for representing English characters as numbers on a computer.  Integer numbers are whole numbers that do not contain a fractional part.  Floating-point numbers are real numbers that contain a fractional part.  Floating-point numbers are always expressed as 

Floating point number = (sign)*(fraction)*(base exponent-bias).

Each of these variable types will be discussed briefly.

Hexadecimal – 
The hexadecimal number system is a base 16 system that uses the values 0-9 and A-F to represent decimal numbers.  Hexadecimal values are often display with the suffix “H”, such a 33a5H for the value 33a5.  The following chart displays the conversion between decimal, binary, and hexadecimal.

	Decimal
	Binary
	Hexadecimal

	0
	0000
	00H

	1
	0001
	01H

	2
	0010
	02H

	3
	0011
	03H

	4
	0100
	04H

	5
	0101
	05H

	6
	0110
	06H

	7
	0111
	07H

	8
	1000
	08H

	9
	1001
	09H

	10
	1010
	0AH

	11
	1011
	0BH

	12
	1100
	0CH

	13
	1101
	0DH

	14
	1110
	0EH

	15
	1111
	0FH

	16
	1 0000
	10H


Decimal-binary-hexadecimal conversion chart.

ASCII – 
ASCII is shorthand for American Standard Code for Information Interchange.  The ASCII code was designed to represent English characters as numbers on a computer.  In modern usage, ASCII is a byword for raw, text-only files.

EBCDIC – 
EBCDIC is shorthand for Extended Binary Coded Decimal Interchange Code.  The EBCDIC code was designed by IBM to represent English characters as numbers on a computer.  The EBCDIC code is used to store information in the SEG Y reel header.

Short Integers – 
A two-byte integer value that may be signed or unsigned.  If signed, 1 bit is allocated for a sign bit and 15 bits are allocated to store the sample value.  Therefore, the possible range of data values for a signed Short Integer is –215 to 215-1, or –32,768 to 32,767.  If unsigned, all 16 bits are allocated to store the sample value.  Therefore, the possible range of data values for an unsigned Short Integer is 0 to 216-1, or 65,535.

Long Integers – 
A four-byte integer value that may be signed or unsigned.  If signed, 1 bit is allocated for a sign bit and 31 bits are allocated to store the sample value.  Therefore, the possible range of data values for a signed Long Integer is –231 to 231-1, or –2,147,483,648 to 2,147,483,647.  If unsigned, all 32 bits are allocated to store the sample value.  Therefore, the possible range of data values for an unsigned Long Integer is 0 to 232-1, or 4,294,967,296.

IBM Float – 
A floating point format in which contains 1 sign bit, 7 bits for the exponent, and 24 bits for the fraction.

IEEE Float – 
A floating point format in which contains 1 sign bit, 8 bits for the exponent, and 23 bits for the fraction.

Example:
SEG-Y Format

The SEG-Y format is a demultiplexed seismic data format that consists of a 3600-byte reel identification header followed by trace data blocks (fig.1).  The reel identification header consists of a 3200-byte EBCDIC (Extended Binary Coded Decimal Interchange Code) text file header and a 400-byte binary file header.  Each of these two blocks contains information specific to the seismic data in the file.  The trace data block consists of a 240-byte binary coded trace identification header followed by the trace data samples. There is one trace identification header per trace.  For more information concerning the SEG-Y Format standard, consult the SEG digital tape standards at 

http://seg.org/publications/tech-stand/

To analyze a SEGY file, use the Select file… button in the File Analysis window to open the Open Input Disk File dialog. The Open Input Disk File dialog is used to maneuver through the directory structure and select a SEG-Y data file for analysis.  After the desired SEG-Y file has been selected, click on the Open button in the lower right corner of the Open Input Disk File dialog.  Once the SEG-Y file is selected, the File Analysis window will display: (1) the name of the file directly beneath the Select file… button; (2) the size of the file, in bytes, in the lower right corner; (3) and the byte position in the file at which the File Analysis utility is currently pointed.
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Figure 1.  Schematic representation of a SEG-Y data file.
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Open Input Disk file Dialog
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SEG-Y file selected for analysis.  Byte position in the file and the file size, in bytes, are displayed in lower right corner.

A great deal of information can be extracted from a properly written SEG-Y reel header.  As stated above, the reel header consists of a 3200-byte EBCDIC text header and a 400-byte binary header.   To read the EBCDIC header, set the dump format to EBCDIC using the drop down menu, and instruct the File Analysis utility to read the first 3200-bytes by entering this value in the parameter field to the right of the Read button in the File Control submenu.  

[image: image15.png]IFile Analysis Window

File Analysis Window

[_Selectiite...

] [ Show dump window |

Gas Pinchout.sgy
Dump format |EBCDIC

Control

Save

[n) bytes Data Byte Order
Read 3200
Little endian
Seek 1
Integer Sign
1
o

SPW Reports

Select

Byte position in file

0

File size in bytes
229840





Preparing to read a SEG-Y EBCDIC reel header.

To dump the first 3200-bytes of data, click on the READ > button in the File Control submenu.  The dump window will appear with the contents of the EBCDIC header.
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The EBCDIC text header displayed in the File Dump Window.

The SEG-Y EBCDIC reel header contains 40 lines of comment cards, at 80-bytes per line.  These comment cards are used to describe the contents of the SEG-Y file.  After dumping the EBCDIC text header to the File Dump Window, the File Analysis utility is positioned at byte 3200 of the selected SEG-Y file, which is the correct position to read the 400-byte binary reel header.  To read the binary reel header, set the dump format to Short Integer, the Data Byte Order to Big Endian, the Integer Sign to Unsigned, and instruct the File Analysis utility to read the next 400-bytes by entering this value in the parameter field to the right of the Read button in the File Control submenu.  Click on the READ > button in the File Control submenu to dump binary reel header.
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Preparing to read a SEG-Y binary reel header.
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The Binary reel header displayed in the File Dump Window.

The first 60-bytes of the SEG-Y binary reel header are assigned values that are described in the SEG-Y standard.  The remaining 340-bytes are left unassigned and may contain any information that the processor deems necessary.  The binary reel header displayed in the File Dump window in the figure above contains the bare minimum of information regarding the seismic file:  (1) bytes 13-14 (bytes 3213-3214 in the file) indicate the number of data traces per record, in this case 48; (2) bytes 17-18 (bytes 3217-3218 in the file) indicate the sample rate in microseconds, in this case 4000; (3) bytes 21-22 (bytes 3221-3222 in the file) indicate the number of samples per data trace, in this case 300; and (4) bytes 25-26 (bytes 3225-3226 in the file) indicate the data sample format code, in this case 1 (1 = 4-byte IBM floating point).

After dumping the binary reel header to the File Dump Window, the File Analysis utility is positioned at byte 3600 of the selected SEG-Y file, which is the correct position to read the 240-byte trace header corresponding to the first trace in the file.  To read the trace header, set the dump format to Short Integer, the Data Byte Order to Big Endian (or as appropriate), the Integer Sign to Signed, and instruct the File Analysis utility to read the next 240-bytes by entering that value in the parameter field to the right of the Read button in the File Control submenu.  Click on the READ > button in the File Control submenu to dump trace header.
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Preparing to read a SEG-Y trace header.
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The trace header displayed in the File Dump Window.

All 240-bytes of the SEG-Y trace header are assigned values that are described in the SEG-Y standard.  The binary trace header displayed in the File Dump window in the figure above contains the trace information specific to the first data trace in the seismic file:  (1) bytes 1-4 (bytes 3601-3604 in the file) indicate the trace sequence number in the line, in this case 1; (2) bytes 9-12 (bytes 3609-3612 in the file) indicate the field record number, in this case 15;  (3) bytes 17-20 (bytes 3617-3620 in the file) indicate the source point number, in this case 129; (4) bytes 21-24 (bytes 3621-3624 in the file) indicate the CMP number of the data trace, in this case 116;  (5) bytes 29-30 (bytes 3629-3630 in the file) indicate the trace identification code, in this case 1 (1 = seismic);  (6) bytes 37-40 (bytes 3637-3640 in the file) indicate the source-receiver offset, in this case -2730;  (7) bytes 41-44 (bytes 3641-3644 in the file) indicate the receiver group elevation, in this case 2137; (8) bytes 45-48 (bytes 3645-3648 in the file) indicate the surface elevation at the source, in this case 2124.  A complete description of the SEGY standard is available from the Society of Exploration Geophysicists.

After dumping the trace header to the File Dump Window, the File Analysis utility is positioned at byte 3840 of the selected SEG-Y file, which is the starting position of the first trace data block.  Each trace data block consists of 300 4-byte floating-point data samples, for a total of 1200-bytes.  To read the trace data block, set the dump format to IEEE Float, the Data Byte Order to Big Endian, and instruct the File Analysis utility to read the next 1200-bytes by entering this value in the parameter field to the right of the Read button in the File Control submenu.  Click on the READ > button in the File Control submenu to dump the trace data block.
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Preparing to read a SEG-Y trace data block.
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The trace data block corresponding to trace 1 of the data file displayed in the File Dump Window.

After dumping the first trace data block to the File Dump Window, the File Analysis utility is positioned at byte 5040 of the selected SEG-Y file, which is the starting position of the second trace header.  To read the second trace header, set the dump format to Short Integer Float, the Data Byte Order to Big Endian, the Integer Sign to Signed, and instruct the File Analysis utility to read the next 240-bytes by entering this value in the parameter field to the right of the Read button in the File Control submenu.  Click on the READ > button in the File Control submenu to dump the second binary header.
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The second trace header, corresponding to trace 2, of source point 115.  The source-receiver offset is –2640 and the CMP location is 117.

Example:
SEG-D Format

The SEG-D format is really a family of seismic data acquisition formats that may be used to record both multiplexed and demultiplexed data. The original SEG-D tape standard was published in 1975 (Geophysics, 40, no. 02, 344-352) and has been revised twice to keep up with changes in the seismic data acquisition environment (Geophysics, 59, no. 04, 668-684; Geophysics, 62, no. 03, 1004-1031).  

A basic SEG-D demultiplexed file format (fig. 2) consists of one or several 32-byte General Header blocks followed by one or several 32-byte Channel Set Descriptor blocks.  The General Header blocks contain information specific to the seismic data in the file and the acquisition hardware used to acquire that data.  An important aspect of the SEG-D family of formats is that SEG-D is self defining in the sense that information contained in the first General Header block specifies both the number of subsequent General Header blocks as well as the length of the data record. A Channel Set Descriptor block contains information specific to a single channel set, which is defined as a group of channels operating with identical recording parameters.  The General Header and Channel Set Descriptor blocks are followed by the Channel sets, which consist of a number of 20-byte trace headers with their associated trace data samples. The trace headers contain basic information, such as file number and channel number, which are specific to their associated seismic trace.  There is one trace header per seismic data trace.  For more information concerning the SEG-D Format standards, consult the SEG digital tape standards at: 

http://seg.org/publications/tech-stand/

To analyze a SEG-D file, use the Select file… button in the File Analysis window to open the Open Input Disk File dialog. The Open Input Disk File dialog is used to maneuver through the directory structure and select a SEG-D data file for analysis.  After the desired SEG-D file has been selected, click on the Open button in the lower right corner of the Open Input Disk File dialog.  Once the SEG-D file is selected, the File Analysis window will display: (1) the name of the file directly beneath the Select file… button; (2) the size of the file, in bytes, in the lower right corner; (3) and the byte position in the file at which the File Analysis utility is currently pointed.
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Figure 2.  Schematic representation of a SEG-D data file.
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SEG-D file selected for analysis.  Byte position in the file and the file size, in bytes, are displayed in lower right corner.

The SEG-D general header blocks contain information specific to their associated seismic data file, such as the file number, the SEG-D format code, the time of shooting, the sampling interval, and the record length.  As stated above, a SEG-D demultiplexed file consists of one or several 32-byte General Header blocks followed by one or several 32-byte Channel Set Descriptor blocks.  The original SEG-D format had one general header block followed by one or several Channel Set Descriptor blocks. SEG-D revisions 1 and 2 contain a minimum of two general header blocks and allow for additional general header blocks should the need arise.  The number of additional general header blocks is indicated in General Header block #1.
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All values in the general header blocks are written as packed binary coded decimal, unless otherwise specified.  To read the general header, set the dump format to Hexadecimal using the drop down menu, and instruct the File Analysis utility to read the first 32-bytes by entering this value in the parameter field to the right of the Read button in the File Control submenu.  

Preparing to read a SEG-D general header block.

To dump the currently selected 32-bytes of data, click on the READ > button in the File Control submenu.  The dump window will appear with the contents of the first 32-byte general header.
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The first general header block displayed in the File Dump Window.

Each of the eight-character strings in the dump represents 4-bytes of the file.  Eight strings equal 32-bytes.  The SEG-D format code, 8058, in bytes 3-4, indicates that this file was written in one of the revised SEG-D formats (i. e. revision 1 or 2).  SEG-D 8058 was not supported in the original SEG-D format description.  In SEG-D 8058 data samples are written to file as 32-bit IEEE demultiplexed floating point values.   The ‘ffff’ in bytes 1-2 indicates that the file number is greater than 9999 and is written in bytes 1-3 of general header block #2.  The last two digits of the year (03), the Julian day (99), the hour (11), the minute (25), and the second (48) at the time of recording are contained in byte 11, byte 12 bits 5-8 and byte 13, byte 14, byte 15, and byte 16, respectively.  The number of additional general header blocks (1) is contained in the first four bits of byte 12.  This means that there are two general header blocks in total.  The sample interval (0.5 ms) is coded as a binary number in byte 23.  The ‘fff’ in byte 26 bits 5-8 and byte 27 indicates that the record length has been written in bytes 15-17 of general header block #2.  The scan types per record (1) and number of channel sets per scan type (2) are contained in byte 28 and byte 29, respectively.  Bytes 30, 31, and 32 indicate that there are no skew blocks, extended header blocks, or external header blocks.  In summary, general header block #1 reveals that there are a total of two general header blocks and two channel set descriptor blocks prior to the first 20-byte trace header block.  Therefore, the complete file header along with the first trace header can be dumped with 148 bytes (32 bytes + 32 bytes + 32 bytes +32 bytes + 20 bytes = 148 bytes), and the first data sample should be found at byte 149.
To dump the complete file header and the first trace header, reposition the File Analysis utility at the start of the file by clicking on the Go to Start button in the lower-left corner of the File Analysis window.  This will cause the Byte Position in File indicator to return to ‘0’.  Set the dump format to Hexadecimal using the drop down menu, and instruct the File Analysis utility to read the first 148-bytes by entering this value in the parameter field to the right of the Read button in the File Control submenu.  Click on the READ > button to display the contents of the complete file header and the first trace header.
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General header blocks 1 and 2, channel set descriptor blocks 1 and 2, and the first trace header displayed in the File Dump Window.
The first 32 bytes of the dump are the contents of the first general header block.  The next 32 bytes are the contents of the second general header block, which contain the field file number (101003) as a hexadecimal value in bytes 1-3, the SEG-D revision number (1) in byte 11, and the record length (1000 ms) as a hexadecimal value in bytes 15-17.  Bytes 20-32 are not defined in revision 1 of the SEG-D format.  The fourth and fifth lines in the File Dump Window display the contents of the two Channel Set Descriptor blocks.   In each case the scan number is in bytes 1-2 and the channel set is in bytes 3-4.  The number of channels in the channel set is contained in bytes 9-10.  Channel set one consists of 144 channels and channel set two is empty.  The channel type indicator is in the first 4 bits of byte 11.  Channel set one consists of seismic channels (1), and channel set two consists of channels described as “other” (7).   The frequency of the anti-alias filter in Hertz and the roll-off of the filter in dB/octave are contained in bytes 13-14 and bytes 15-16, respectively.  In each case, the frequency of the anti-alias filter is 1000 Hz and the roll-off is 24 dB/octave.  The value of 1 in byte 30 of the channel set descriptor blocks indicates that the traces are unstacked.  The final 20 bytes are the contents of the first trace header, which contains the scan number (1) in byte 3, the channel set (1) in byte 4, the trace number (1) in bytes 5-6, and the field file number (101003) in bytes 18-20.

The File Analysis utility is currently positioned at byte 148 of the selected SEG-D file.  The trace data in each seismic file was sampled at 0.5 ms intervals with a record length of 1000 ms. Therefore, each seismic trace consists of 2000 32-bit (4 bytes) samples.  To read the first 8 data samples in the first trace of the first file, set the dump format to IEEE Float, the Data Byte Order to Big Endian, and instruct the File Analysis utility to read the next 32-bytes by entering this value in the parameter field to the right of the Read button in the File Control submenu.  Click on the READ > button in the File Control submenu to dump the trace data samples.
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The first 8 data samples from trace 1 of the first file. 

To read the second trace header file we need to skip forward to the end of the first traces data samples.  The end of the first trace data is located at byte 8148 (64 bytes General Header + 64 Bytes Channel Set Descriptor + 20 bytes 1st Trace Header + 8000 bytes of the first data trace = 8148 bytes).  To go to byte 8148 enter this value in the parameter box to the right of the Go to Byte button and the click on the button.  Set the dump format to Hexadecimal, and instruct the File Analysis utility to read the next 20-bytes by entering this value in the parameter field to the right of the Read button in the File Control submenu.  Click on the READ > button in the File Control submenu to dump the second trace header.
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Preparing to read the second trace header.
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The contents of the second trace header. 

As expected, the second trace header indicates that it is trace 2 of file 101003.

Data Reformat

The Data Reformat utility is designed to efficiently reformat tape and disk files from foreign seismic and radar formats to SPW format, from foreign formats to SEG-Y format, and from SPW format to SEG-Y format. To use the Data Reformat utility, simply click on the Data Reformat button in the Main Window and the Reformat window will appear.
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Main Window
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Reformat Window

The remainder of the chapter will:  (1) discuss the various features of the Reformat window; (2) explain the various formats that the Data Reformat utility is capable of reformatting; (3) provide examples in which actual SEG-Y and SEG-D data files are reformatted to SPW format; (4) and detail the steps required to correctly reformat a SPW file to a SEG-Y formatted file.

Reformat Window
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 The Reformat Window.

Dialog Parameters 
Select Input Device – Select the input file location and format.

Tape – Used to select input files that are on an external tape drive.

Disk File – Used to select input files that are on a disk file.

Data type – Used to set the input data format.

Parameters – Used to set or change specific input data format parameters.

Select Output Device – Select the output file location and format.

Tape – Used to select output files that will be on an external tape drive.

Disk File – Used to select output files that will be on a disk file.

Data type – Used to set the output data format.

Parameters – Used to set or change specific output data format parameters.

Error handling – Opens the Error Handling dialog, which provides an option for stopping data reformat from an external tape drive if there are tape media errors.

Execute – Used to execute a reformat job once the input and output parameters have been fully specified.

Close – Close the Reformat window.

Job Status – Lists the status of any reformat activity.  Prior to the execution of a reformat job, the Job Status is “Idle”.  When reformatting, the Job Status is “Running”.  If the reformat was executed successfully, the Job Status is “Complete”.  If the reformat was not executed successfully, the Job Status is “Failed”.  

Format Types

The Data Reformat utility is designed to reformat files from foreign seismic and radar formats to SPW format, from foreign formats to SEG-Y format, and from SPW format to SEG-Y format. The foreign seismic and radar formats currently handled by the IO Utility Reformat utility include:


ABEM – ABEM Terraloc Mk3, Mk4, Mk5, and Mk6 seismograph formats.

AMOCO - AMOCO internal format.


Bison 2 – Bison seismograph format.


EG&G – EG&G Geometrics seismograph format.


GSSI – Geophysical Survey Systems Inc. ground penetrating radar format.


MALA – Mala Geoscience ground penetrating radar format.


OYO – Oyo Instruments DAS seismograph format


Reftek – Reftek seismic format for Texan recorders.

SCINTREX – Scintrex seismic data format.

SEG-2 – Raw and processed shallow seismic or digital radar data format.


SEG-A – Seismic data acquisition format for binary gain, 2-byte recording systems.


SEG-B – Seismic data acquisition format for binary gain, 2-byte recording systems.


SEG-C – Seismic data acquisition format for true floating-point recording systems.


SEG-D – Industry standard seismic data acquisition format.


SEG-Y – Seismic data exchange format.


SENSORS – Sensors and Software ground penetrating radar format.


SPW – Parallel Geoscience Corp. internal format.
Tensor – Tensor Geophysical Corp. internal format.

Example:
Reformat from SEG-Y Format

The SEG-Y format is primarily used as a data exchange format. The original SEG-Y tape standard was published in 1975 (Geophysics, 40, no. 02, 344-352) and was revised once in 2002 to keep up with changes in the seismic data acquisition.  For a complete description of the SEG-Y Format standard, consult the SEG digital tape standards at:

http://seg.org/publications/tech-stand/

To reformat a SEGY file from disk, set the input Data type to SEGY with the appropriate drop down menu, and use the input Disk file button to open the Open Input Disk File dialog. The Open Input Disk File dialog is used to maneuver through the directory structure and select a SEG-Y data file for reformat.  Next, set the output Data type to SPW with the appropriate drop down menu, and use the output Disk file button to open the Save dataset as dialog. The Save dataset as dialog is used to maneuver through the directory structure and set/create a SPW file for output from the reformat.  

By default, the Reformat utility is designed to reformat SEG-Y using a trace header structure defined by the SEG-Y standard.  This standard is defined in a read-only format file (iosegy.tfm) that comes as part of the SPW software installation.  If your data conforms to the standard, all that you need to do to reformat the SEG-Y file to SPW format is click Execute.  The SEG-Y EBCDIC header will be displayed in the Console window, and if the reformat is executed successfully, the Job Status will indicate ‘Complete’.
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Select the SEG Y input file and the SPW output file.

If your SEG-Y data contains non-standard trace header information that is required to successfully reformat the data, or that you would liked to be mapped into the SPW trace header, additional format instructions are necessary.  To access the SEG Y Input format definitions, click on the Parameters… button in the Reformat window.  Starting from the top of the SEG Y Input Format dialog are the following subwindows:
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Click on the Parameters… button in the Reformat window to access the SEG Y Input Format parameter dialog.

SEGY Format File – This subwindow indicates the format file that will be used to describe the structure of the SEG-Y reel header and trace headers during data reformat. If any changes are made to the Reel Header, the Binary Header, or the Trace Header definitions, those definitions can be saved for future use by clicking on the Save button and creating a new file.

Reel Header – The standard SEG-Y reel header consists of a 3200-byte EBCDIC text header and a 400-byte binary header.  By default both are present.  

Binary Header – The standard SEG-Y reel header consists of a 3200-byte EBCDIC text header and a 400-byte binary header.  By default both are present. To edit or review the binary header field definitions, click on the Field Definitions… button.  The header fields displayed in the SEGY Binary Header Fields Definition dialog are the header field that the SEG Y standard strongly recommends be recorded in the binary header.  To review the default description of any of the required header fields, select the field and then click on the Edit Field button.  An Edit Binary Header Field dialog will display information particular to that header field.   

For example, select Sample interval and click on Edit Field.  The resulting Edit Binary Header Field dialog reveals that the sample interval, as defined by the SEG Y standard, is coded as a short integer in bytes 17-18 of the binary reel header.  If the sample header has been coded differently in the SEG Y data you wish to reformat, update the Edit Binary Header Field dialog accordingly.
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Click on the Field Definitions… button in the Binary Header submenu of the SEG Y Input Format window to access the SEG Y Binary Header Field Definitions dialog.
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Click on the Edit Field button in the SEG Y Binary Header Field Definitions dialog to access the Edit Binary Header Field dialog.

Trace Header – A standard SEG-Y formatted file consists of a 240-byte of binary coded trace header appended to each traces data samples.  To edit or review the trace header mapping from SEG Y to SPW, click on the Field Definitions… button.  The header fields displayed in the SEGY to SPW Mapping List window are obtained by default, though the mapping will only be correct if the SEGY headers are in their standard prescribed locations.  To review the default description of any of the SEG Y header fields, select that field in the SEG Y Trace Header window, and then click on Edit Field button.  An Edit Trace Header Field dialog will display information particular to that header field.   

For example, select CDP number in the SEG Y Trace Header window and click on Edit Field.  The resulting Edit Trace Header Field dialog reveals that the CDP number, as defined by the SEG Y standard, is coded as a long integer in bytes 21-24 of the binary trace header.  If the trace header has been coded differently in the SEG Y data you wish to reformat, update the Edit Trace Header Field dialog accordingly.
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Click on the Field Definitions… button in the Trace Header submenu of the SEG Y Input Format window to access the SEG Y Trace Header Field Definitions dialog.
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Click on the Edit Field button in the SEG Y Binary Header Field Definitions dialog to access the Edit Binary Header Field dialog.

More Parameters… – The More Parameters… button opens the SEG Y Input Options dialog.  This dialog contains the following subwindows:
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Click on the More Parameters… button in the SEG Y Input Format window to access the SEG Y Input Options dialog.

Trace Type Values – Bytes 29-30 of the binary trace header contain a trace identification code that is used to distinguish normal seismic traces from non-standard seismic traces such as sweeps, time breaks, upholes, etc.  The SEG Y standard identifies a seismic trace as ‘1’, a dead trace as ‘2’, a dummy trace as ‘3’, a time break as ‘4’, an uphole trace as ‘5’, a sweep trace as ‘6’, a timing trace as ‘7’, and a water break trace as ‘8’.  

Vibroseis Correlation – Not active.

Swap Bytes – By default, the Reformat utility will detect the byte order (big endian or little endian) of the data samples from the sample format field.

Strip auxiliary traces – If checked, the Reformat utility will strip any auxiliary traces from the input file prior to reformatting the data.

Example:
Reformat from SEG-D Format

The SEG-D format is really a family of seismic data acquisition formats that may be used to record both multiplexed and demultiplexed data. The original SEG-D tape standard was published in 1975 (Geophysics, 40, no. 02, 344-352) and has been revised twice to keep up with changes in the seismic data acquisition environment (Geophysics, 59, no. 04, 668-684; Geophysics, 62, no. 03, 1004-1031).  For a complete description of the SEG-D Format standard, consult the SEG digital tape standards at:

http://seg.org/publications/tech-stand/

To reformat a SEG-D file from disk, set the input Data type to SEGD with the appropriate drop down menu, and use the input Disk file button to open the Open Input Disk File dialog. The Open Input Disk File dialog is used to maneuver through the directory structure and select a SEG-D data file for reformat.  Next, set the output Data type to SPW with the appropriate drop down menu, and use the output Disk file button to open the Save dataset as dialog. The Save dataset as dialog is used to maneuver through the directory structure and set/create a SPW file for output from the reformat.  

By default, the Reformat utility is designed to reformat demultiplexed SEG-D data using information provided in the SEG-D header.  As such, no user input is required for the majority of SEG-D data types.  Simply click Execute, and if the reformat is executed successfully the Console window will display the SEG-D revision number, the SEG-D format code, the sample interval, the trace length, and the number of channels per record
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Select the SEG D input file and the SPW output file.
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Click on the Parameters… button in the Reformat window to review the SEG D format input parameters.

Outputting SPW files in SEG-Y format

The creation of standard SEG-Y files from SPW files is a straightforward task.  By default, the Reformat utility is designed to map SPW trace header values to the corresponding SEG-Y trace header locations according to a read-only format file (tusegy.tfm) that comes as part of the SPW software installation.  The default EBCDIC reel header is a blank 3200 byte block that contains no information.  The default binary reel header is 400 bytes and the default binary trace header is 240 bytes.  Both contain all of the information that has been described as mandatory in the SEG-Y standard.  For a complete description of the SEG-Y Format standard, consult the SEG digital tape standards at:

http://seg.org/publications/tech-stand/

To output an SPW file as a SEGY file on disk, set the input Data type to SPW with the appropriate drop down menu, and use the input Disk file button to open the Open Input Disk File dialog. The Open Input Disk File dialog is used to maneuver through the directory structure and select the SPW data file that will be reformatted.  Next, set the output Data type to SEG-Y with the appropriate drop down menu, and use the output Disk file button to open the Save dataset as dialog. The Save dataset as dialog is used to maneuver through the directory structure and set/create a SEG Y file for output from the reformat.  
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Select the SPW input file and the SEG Y output file.

If you would like to create an EBCDIC header or map additional information into either the SEG-Y binary reel header or the SEG-Y trace header, additional format instructions are necessary.  To access the SEG Y Output format definitions, click on the Parameters… button in the Reformat window.  Starting from the top of the SEG Y Output Format dialog are the following subwindows:
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Click on the Parameters… button in the Reformat window to access the SEG Y Output Format parameter dialog.

SEGY Format File – This subwindow indicates the format file that will be used to describe the structure of the SEG-Y reel header and trace headers during data reformat. If any changes are made to the Reel Header, the Binary Header, or the Trace Header definitions, those definitions can be saved for future use by clicking on the Save button and creating a new file.

Reel Header – The standard SEG-Y reel header consists of a 3200-byte EBCDIC text header and a 400-byte binary header.  Although by default both are present, the EBCDIC header remains blank unless updated by the user.  The quickest way to create an EBCDIC header for your SEG-Y data file is through a simple Windows based text editor application such as Notepad.  Simply open a blank document and create a file that contains 40 lines of eighty characters, keeping in mind that the return character represents a hidden character (or 1 byte).  The raw document would look something like this:

Unedited EBCDIC Reel header.
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After updating the EBCDIC header, it may look something like this:

An example of an EBCDIC Reel header.

To insert the EBCDIC text header you have created into the reel header of the reformatted SEG-Y data file, first activate the Open… button by checking the Create header from text file box, then use the Open… button to select the text file.
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Select the text file used to construct the EBCDIC reel header.

Binary Header – The standard SEG-Y reel header consists of a 3200-byte EBCDIC text header and a 400-byte binary header.  To edit or review the binary header field definitions, click on the Field Definitions… button.  The header fields displayed in the SEGY Binary Header Fields Definition dialog are the header field that the SEG Y standard strongly recommends be recorded in the binary header.  To review the default description of any of the required header fields, select the field and then click on the Edit Field button.  An Edit Binary Header Field dialog will display information particular to that header field.   

For example, select Sample interval and click on Edit Field.  The resulting Edit Binary Header Field dialog reveals that the sample interval, as defined by the SEG Y standard, will be coded as a short integer in bytes 17-18 of the binary reel header.  
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Click on the Field Definitions… button in the Binary Header submenu of the SEG Y Input Format window to access the SEG Y Binary Header Field Definitions dialog.
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Click on the Edit Field button in the SEG Y Binary Header Field Definitions dialog to access the Edit Binary Header Field dialog.

Trace Header – A standard SEG-Y formatted file consists of a 240-byte of binary coded trace header appended to each traces data samples.  To edit or review the trace header mapping from SPW to SEG0-Y, click on the Field Definitions… button.  The header fields displayed in the SPW to SEGY Mapping List window are obtained by default, though the mapping will only be meaningful if the SPW headers contain the listed information.  To review the default description of any of the SEG Y header fields, select that field in the SEG Y Trace Header window, and then click on Edit Field button.  An Edit Trace Header Field dialog will display information particular to that header field.   

For example, select Cmp location => CDP number mapping in the SPW to SEG Y Mapping List window and click on Edit Field.  The resulting Edit Trace Header Field dialog reveals that the CDP number, as defined by the SEG Y standard, will be coded as a long integer in bytes 21-24 of the binary trace header.  If you would like the SEG Y trace header to be coded differently, update the Edit Trace Header Field dialog accordingly.  However, keep in mind these are the byte locations where the CDP number is expected to reside.
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Click on the Field Definitions… button in the Trace Header submenu of the SEG Y Output Format window to access the SEG Y Trace Header Field Definitions dialog.
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Click on the Edit Field button in the SEG Y Binary Header Field Definitions dialog to access the Edit Binary Header Field dialog.

Tape Image Copy
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The Tape Image Copy capability allows you to (1) copy files from any attached SCSI tape drive to another attached SCSI tape drive, (2) copy from a SCSI tape drive to a disk image file, and (3) copy from a disk image file to an attached SCSI tape drive. To use the Tape Image Copy utility, simply click on the Tape Image Copy button in the Main Window and the Copy window will appear.
Main Window dialog
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Copy Window dialog

The remainder of the chapter will: (1) discuss the various features of the Copy Window; (2) discuss the input and output formats that the Copy Window supports; and (3) provide examples of tape image copies of unformatted, SEG-Y, and SEG-D data from one tape to another.

Copy Window
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The Copy Window.

Parameter Dialog
Select Input Device – The Select Input device options are used to select the file to be copied, the format of the file, and the range of data in the file that will be copied to output.
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Tape - The Tape button opens the Input Tape Select dialog, which is used to select attached SCSI tape drive containing a tape with data to be copied.

No rewind on close – The input tape will not be rewound at the end of the tape copy session.

Unload on EOT – Tape automatically unloads when the end of tape marker is found

Auto-loader – Indicates that an auto-loader will be used to load multiple input tapes.

M4 mode – Check M4 mode if an M4 tape drive is selected.

Disk -
The Disk button opens the Open Input Disk File dialog, which is used to select a disk file that contains data to be copied.  
[image: image208.png][Execution started For file Execution example.cpf -
hursday, February 20, 2083 88:48:59
Initial Phase called for process : Create Spikes

fspike Nunber 1:
First Trace with spike = 1
Last Trace with spike = 48
Tine on first trace 100
Tine on last trace 140
Scale of spike = -1.6000

tain Phase called for process : Create Spikes wecord number 1

[Final Phase called for process : Create Spikes

initial Phase called for process : Urite Seismic File
fain Phase called for process : Urite Seismic File record nunber 1
[Final Phase called for process : Urite Seismic File

[Execution took 9.163 seconds.

[Execution completed for file Execution example.cpf .





Data type -
The Data type drop down menu is used to select the format of the file to be copied.  Available formats include Unformatted, SEG-Y, and SEG-D

Parameters -
The Parameters button is used to specify copy parameters for the data type selected in the Data type drop down menu.  The parameter dialog for each of these data type will be discussed at length in the sections below.

Select Output Device – The Select Output device options are used to select the output file that will contain the tape image copy.
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Tape - The Tape button opens the Output Tape Select dialog, which is used to select an attached SCSI tape drive that will contain the tape image copy.

No rewind on close – The output tape will not be rewound at the end of the tape copy session.

Use multiple outputs – In the case of a SEGD tape image copy, indicates that multiple output tapes will be used.

Unload on EOT – Tape automatically unloads when the end of tape marker is found

Auto-loader – Indicates that an auto-loader will be used to load multiple output tapes.

Disk -
The Disk button opens the Save dataset as dialog, which is used to select a disk file that will contain the tape image copy.

Error Handling – The Error Handling button opens a dialog that allows the tape copy to stop in the case of input tape media errors.

Execute – The Execute button is used to initiate the tape copy.

Close – The Close button is used to exit the Copy Window at the end of a tape copy session.

Job Status – Lists the status of any tape copy activity.  Prior to the execution of a tape copy job, the Job Status is “Idle”.  When copying, the Job Status is “Running”.  If the copy was executed successfully, the Job Status is “Complete”.  If the copy was not executed successfully, the Job Status is “Failed”.

Input data types

The Tape Image copy utility is capable of copying Unformatted, SEG-Y or SEG-D formatted data files. Each of these formats has a corresponding Parameters dialog. 
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The drop down window of input formats.

Unformatted

The Unformatted copy is designed for bit-for-bit copy of data from an attached SCSI tape drive to disk. The parameter dialog for the Unformatted copy allows you to specify the type of the output file as well as the mode for reading the input tape. The .tpf file format is a SPW disk file format that contains special information about both the structures of the tape file as well as the data in the tape file. The .tpf file format allows you to input a tape, copy the data contained on that tape to disk, and then output the disk file to another tape with the exact information and blocking structure contained on the original tape.  This is very useful in the field when you only have one tape drive.  The .tim format is the stream data as it was read from tape.
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The Unformatted Copy Parameter dialog.

SEG Y

The SEG-Y copy is designed to read in SEG Y data from tape and copy it either to disk or to tape.  The SEG Y Copy Parameters dialog allows the user to modify the standard copy operation by (1) range limiting the input dataset according to trace header values, and (2) sorting the output file by as many as three trace header values.  Any header words in the SEG Y trace header may be specified as control points to range limit the input data or sort the output data. The control points may be entered manually or may be input from a file. 
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The SEG Y Copy Parameters dialog.

In order to properly use the range-limiting feature of SEG Y copy, it is important to understand how to define the range of input values.  The region of data to be output from the copy is the set of traces that falls within the closed polygon described by the control points.  Since the control points describe a closed polygon, it is essential that the ordered pairs of header values (from the primary and secondary header fields) be listed - either manually or in the input text file – in sequential order around the perimeter of the polygon being described. 

For example, if you wanted to output all traces within a rectangle defined by the inline range 200-500 and the crossline range 100-400 (fig. 1), the set of ordered pairs used to describe the bounding rectangle would be:


200, 100
200, 400
500, 400
500, 100

Note that it is not necessary to 'close' the polygon explicitly. IO Utility will assume a closing boundary between the first control point and the last control point.
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Figure 1.  The output region defined by the ordered pairs (200,100), (200,400), (500,400), and (500,100).

To range limit the input, check the Range limit by header field box in the SEG Y Copy Parameters dialog.  The any pair of trace header values may be used to range limit the output data and the ranges may be defined manually in the SEG Y Copy Parameters dialog or in a file accessed through the Browse button.  By default, the primary and secondary trace header field used to range limit the data are the inline number (bytes 193-196 of a standard SEG Y trace header file) and the crossline number (bytes 21-24 of a standard SEG Y trace header file).
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Read the control points from a file.

To range limit the input from a file that specifies the control points illustrated in figure 1, check <Read control points from a file>, and use the Browse button to read a simple text file with one inline (primary) - crossline (secondary) pair per line:  

200, 
100

200,
400

500,
400

500,
100

To manually range limit the input according to the control points illustrated in figure 1, [image: image214.png]FE Flowchart )
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check <Manually enter control points> and fill in the appropriate values:  

Manually enter the control points.

To sort the output according to trace header values, check the Sort by header fields box, and then set the byte positions in the SEG Y trace header that will control the sort order of the output file.  By default, the output data are sorted according to field file number (bytes 9-12 of a standard SEG Y trace header file) and channel (bytes 13-16 of a standard SEG Y trace header file).  A third trace header value may be used in the sort if needed.

SEG D

The SEG-D copy is designed to read in SEG D data from a disk file or an attached SCSI tape drive and write it to a SCSI tape drive. This option may be useful when the field data are written directly to disk in SEG-D format, as is the case with the Seistronix recording instrument.  The SEG D Copy Parameters dialog allows you to specify a log file that will record the field files transferred during the copy operation.
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 SEG D Copy Parameters Dialog.

[image: image216.png]Fle Edit View Favortes Tools Help
Qback - ) ¥ Osearch [ Foders [F]~

address | pgc

Sze| Type
File and Folder Tasks (& ot .con | 9KB CON Fie
4KB FLO Fie

Make a new foder
2 175 KB FINI File

Date Modified
3/6/2003 2:20 PM
3/6/2003 2:20 PM
3/6/2003 2:20 PM

<





Example SEG D log file.

Creating Multiple Tape Copies

To create to multiple tape copies simultaneously, open the Output Tape Select dialog by clicking the Tape button under Select Output Device. Check the Use multiple outputs option in the Output Tape Select dialog and then select the desired devices through the combined use of the cursor and either the Shift or Ctrl key.
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 Output Tape Select Dialog

Input and Output from more than one tape

When you are reading from multiple tapes and you encounter an end of tape (EOT) marker on the input tape, you will be prompted with the Input Tape Continuation dialog which allows you to load a new input tape to the device and either continue or end the process.
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Input Tape Continuation Dialog

If the Tape Image Copy utility is being used to write multiple SEGD tapes and you encounter an end of tape (EOT) condition on one of the output tapes, you will be prompted with the Output Tape Continuation.  The Output Tape Continuation dialog is similar to the Input Tape Continuation dialog in that it allows you to load a new output tape to the device and continue or to end the process.

SPW File Merge
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The SPW File Merge utility allows you to concatenate several SPW disk files into a single file. To use the SPW File Merge utility, simply click on the SPW File Merge button in the Main Window and the SPW File Merge window will appear.  

Main Window
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SPW File Merge Window

The remainder of the chapter will discuss the various features of the SPW File Merge window.

SPW File Merge Window
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 The SPW File Merge window.

Dialog Parameters
Input SPW Files – Chose the files to be merged.

Add File… – Use the Add File button to open the Open Input File dialog and select one of the files that will constitute the output file.

Add Files in folder… – Use the Add Files in folder button to open the Browse for Folder dialog and select a folder of seismic files that will be merged into an output file.

Remove – Use the Remove button to delete a file in the Input SPW Files list. 

Remove all files – Use the Remove all files button to clear all files from the Input SPW Files list.

Output SPW File – Chose the output file options.

File… – Use the File button to open the Open Output File dialog and select/create the name of the merged output file.

Override file type – If checked, allows the type of the output file to be set manually. 

Unstacked – Output file consists of pre-stack seismic data.

2D Stack – Output file consist of one or several 2D stacks and/or migrations.

3D Stack – Output file consist of one or several 3D stacks and/or migrations.

Execute – Used to execute a file merge job once the input and output parameters have been fully specified.

Close – Close the SWP File Merge window.

Job Status – Lists the status of any merge activity.  Prior to the execution of a file merge job, the Job Status is “Idle”.  When merging files, the Job Status is “Running”.  If the merge was executed successfully, the Job Status is “Complete”.  If the file merge was not executed successfully, the Job Status is “Failed”.  

Example – Merge five stacks into one SPW file.
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Add the first file,  followed by additional files.  Use the File… button in the Output SPW File subwindow to create the output file name.  Click on Execute to generate the output file.

Tape Image Verify

The Tape Image Verify capability allows you to compare files from any combination of attached SCSI tape drives or disk image files. This enables you to verify both media integrity for tape files and byte-level accuracy of image copies made previously. To use the Tape Image Verify utility, simply click on the Tape Image Verify button in the Main Window and the Verify window will appear.
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Main Window dialog
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Verify Window dialog

The remainder of the chapter will: (1) discuss the various features of the Verify Window, and (2) provide an example of verifying a SEG-Y tape image.

Verify Window
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The Verify Window.

Parameter Dialog
Select First Input Device – The Select First Input Device options are used to select the first of two files to be compared.
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Tape - The Tape button opens the Input Tape Select dialog, which is used to select an attached SCSI tape drive containing a tape with data to be verified.

No rewind on close – The input tape will not be rewound at the end of the tape verify session.

Unload on EOT – Tape automatically unloads when the end of tape marker is found.

Auto-loader – Indicates that an auto-loader will be used to load multiple input tapes.

M4 mode – Check M4 mode if an M4 tape drive is selected.

Disk -
The Disk file button opens the Open Disk File dialog, which is used to select a disk file containing data to be verified.  
Select Second Input Device – The Select Second Input Device options are used to select the second of two files to be compared.
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Tape - The Tape button opens the Input Tape Select dialog, which is used to select an attached SCSI tape drive containing a tape with data to be verified.

No rewind on close – The input tape will not be rewound at the end of the tape verify session.

Unload on EOT – Tape automatically unloads when the end of tape marker is found.

Auto-loader – Indicates that an auto-loader will be used to load multiple input tapes.

M4 mode – Check M4 mode if an M4 tape drive is selected.

Disk -
The Disk file button opens the Open Disk File dialog, which is used to select a disk file containing data to be verified.  

Concatenated files – If checked, indicates that the file on the second input device were created by concatenating the original input files.  ,

Tape Read Mode – The Tape Read Mode options do not apply to the Windows version of IO Utility.

Short Block – To be used if the SCSI device reads in data blocks less than or equal to 64kb.  This is the case with Mac OS X.

Long Block – To be used if the SCSI device reads in data blocks larger than 64kb.  This is only an issue on the older Mac OS (pre OS X).

Tape Control Features

A dialog is available from the Window menu on the menubar giving you full control of the position of the tape within the selected drive. 
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Tape Control Dialog

Tape Control Menu

In addition to the Tape Control dialog, there are several tape control operations that can be performed using one of the menu items in the Control menu.  These only appear active when a tape drive is connected to the system.
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  The Control Menu

The same operations can be performed from the menu as from the Tape Control dialog. 
 FlowChart and Executor

The FlowChart application in SPW allows you to build processing flows and set the parameters for processing steps.   The FlowChart application contains four basic sub-windows: (1) the FlowChart design window for creating a processing flow (<UNTITLED> below), the Processing List, the Tool Palette, and the Console. The FlowChart graphical user interface simplifies the process of building a processing flow to a few mouse clicks.
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FlowChart User Interface

The Executor
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The Executor application is the part of the SPW system that runs the processing flow after it has been built in the FlowChart.  It reports such things as processing activity, job errors, and job status. The Executor automatically opens files named with a .cpf extension that reside in the Executor program directory. Once the file is opened and execution starts, the file is renamed to have an extension of .act. After execution is complete, the file is renamed with an extension of .fini. The Executor has only a DOS type console window for a user interface. To stop the Executor, press the Esc key or use the X close box in the upper right corner of the Executor window.

The Executor User Interface

The Executor may be running on the same system as the FlowChart application, or it may can run on a separate computer. The Executor can take full advantage of multiple CPUs, and more than one instance of The Executor may run at any one time.
The messages in the Executor window are written to a disk file in the Executor program directory (by default, C:\ProgramFiles\pgc).  This file has the name of the executed job with an extension of .cpf.con.
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The Output Console File from the Executor

If you encounter problems in running a flow, this console file can greatly assist the Parallel Geoscience Corporation customer support staff in resolving the problem.  It can easily be opened in a text editor for viewing, printed and faxed, or attached to E-mail.

The Main FlowChart Window
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The FlowChart application is used for building and saving processing flows. The FlowChart application is a multi-document interface so multiple FlowChart windows may be open simultaneously.

Example of a processing flow in the main FlowChart window

The Tools Palette

The Tools Palette contains the selection tool and the linking tool.  The user may toggle between the selection tool and the linking tool with a click of the mouse, or with the use of the Tab key on the keyboard. The selection and linking tools are used in building a job flow.
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Tools Palette

The Selection Tool

The Selection Tool (i.e. the black diagonal arrow) is used to select a processing step or open up the parameter dialog of a processing step. When selected, the Selection Tool button will appear depressed.
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Selection Tool selected

When using the selection tool, the items selected will be highlighted by color; the links will become bold green, and the flow items will be enclosed by a blue box.
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Selecting a Link

Once selected you can remove an item or a link by choosing either the Clear command or the Cut command from the Edit menu.  Alternatively, you can use the Delete key on the keyboard.

The Linking Tool

The Linking Tool (i.e. the red vertical arrow) allows you to define the data flow between steps on the chart. When selected, the Linking Tool button will appear depressed.
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Link Tool selected

The data flow is type-checked for validity at the time you draw the link.  If an improper association is made, either directionally or sequentially, the following error message will appear, and the link will not be completed.
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Data Type Error Dialog

The Processing List

The Processing List contains the categories of processing steps available in the SPW system. 
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The Processing List sub-window…

When you click on a button in the Processing List, such as Statics...  a sub-window extension will appear that contains each of the available processing steps in that category.  However, only the steps available in your license will be shown in the selected sub-window.

When you click on the desired processing step button, it will appear depressed.  You must then click in the FlowChart window where you wish the step to be placed before it will appear.  The selected item may then be dragged for further positioning.

The Console Window

The Console Window contains various messages related to the building and compiling of processing flows. These messages may be helpful in finding errors or problems in the building, saving or compiling of processing flows.
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The FlowChart Console Window

The Icons

The FlowChart uses the following four distinct icons:

Processing steps are shown with an icon of:
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Seismic data items are shown with an icon of:
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Card data items are shown with an icon of:
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Sorting steps, which require a disk data file, are shown with an icon of:

[image: image243.png]w10 160
sl





Menu Items

The FlowChart application menu contains the following items:

· File Menu

· Edit Menu

· Display Menu

· Flowchart Menu

· FlowItems

· Help

· Window

The File Menu

In addition to the standard File commands common to most applications, the File menu allows you to open FlowChart Templates, and launch Job Manager, SeisViewer, IO Utility, and Vector Calculator.  A description of templates begins on page 139.
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File Menu

The Edit Menu

The Edit menu contains the edit commands common to most applications. 
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Edit Menu

Cut can be used to remove flow items or links between flow items that have been highlighted with the Selection tool.

Copy and Paste are implemented to copy portions of a flowchart from one flowchart window to another. 

The Insert command is not active.

The Clear command removes the currently selected items from the flowchart window. 

The Select All command selects all items on the active FlowChart canvas.
The Preferences command brings up the Preferences dialog.
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Preferences Dialog

The Preferences dialog is used to set preferences for several execution-related processes.  First, the Browse button allows you to set the target directory into which (1) compiled job flows are written prior to execution, and (2) executed job flow console files are written following execution.  This directory is selected through the use of the Browse button.  By default, this directory contains each of the SPW executable files.  Second, the size of the grid that determines the alignment of processing items on a flow is controlled from the Preference dialog.  Third, the user
Selects whether job execution will run in serial mode on a single CPU, or in parallel mode on a cluster of CPU’s.  Finally, there are three check boxes that give the user additional control over FlowChart behavior.  Each of these items will be described below.
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Check for file existence in Compile – If checked, this causes the compiler to verify the existence of all files required to execute the job flow.  If path names have been incorrectly specified, or links point to non-existent files, the appropriate error message will be displayed in the Console window:

Compile error due to non-existent file(s)

Keep steps selected in the step palette – If checked, the processing step selected from the Processing List will remain active until another processing step has been chosen. As a result you will be able to place as many of the chosen processing steps in the FlowChart window, as you like.

Executor Mode (Compile and Run) – These options allow you to confine the execution of a compiled flow job to a single CPU (i.e. Serial) or to distribute the processes among a cluster of CPU’s (i.e. Parallel) and take advantage of SPW’s parallel processing capabilities.

Serial – If selected, the compiled flow chart will be executed on a single CPU.

Parallel – If selected, the compiled flow chart will be executed on a network of CPU’s consisting of a master and one or several slaves.

Number of streams – Indicate the number of CPU’s on the cluster used for processing.  One node is used for job management (i.e. the head node), and will not be available for processing.  For example, on an 8-node cluster, 7 streams are available for processing.

Host name for job scheduler – The URL path to the Executor.

The Display Menu

The Display menu contains commands that allow the user to (1) display trace header spreadsheets; (2) display seismic, processing step, or card data parameters; (3) turn on or turn off the display of the console sub-window.
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The Display Menu

The Flowchart Menu

The Flowchart menu contains the Compile, Compile and Run, and the Execution Console commands.  
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The Flowchart Menu

The Compile command generates an output binary file containing the flow items and the flow links.  The Compile command is only used for job execution in Parallel mode. This file is named the same as the flowchart document but with an extension of *.cpf.  It is built in a directory specified in the Preferences dialog window that is accessed through the Edit menu. This file is read by the Executor application to run the processing flow.

The Compile and Run command provides a one click method of compiling a binary file and executing the flow. The Compile and Run command is only used for job execution in Serial mode.  While running, the binary file is named the same as the flowchart document but with an extension of *.active.  Upon completion of execution the extension of the binary file converts from *.active to *.done, and an additional *.console file is generated with the same name as the flowchart document. The *.console file contains run time statistic for the job and can be viewed with any text editor or through use of the Execution Console command (see below).  The Compile and Run command is used to execute job flows one at a time.  Batch processing is not possible with the Compile and Run command. 

The Execution Console command launches a text window or windows that display the run time statistics contained in the most recently generated *.console (i.e. the run time statistics generated through use of the Compile and Run command) and *.cfp.con files (i.e. the run time statistics generated through use of the Executor).

The FlowItems Menu

None of the FlowItems commands are currently enabled. When they are implemented, you will be able to customize the Processing List sub-window and rearrange the processing steps into groups that suit your working environment.
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  The FlowItems Menu

The Help Menu

The Help menu contains the About… command, which displays software version information for the application and license key information. 
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 The Help Menu
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Results of selecting About… from the Help menu

The Window Menu

The Window menu allows you to toggle between sub-windows in the FlowChart application. Selecting an item brings the associated sub-window to the foreground of the FlowChart application.
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 The Window Menu

Building a Flow

Building a processing flow is a simple matter of placing the desired processing steps onto a flowchart sub-window.   Select the desired step by first choosing the category from the Processing List with a single click.  A list of steps will appear.  
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Building a Flow

From this list, single-click again to select the particular processing step you wish to place in the flowchart.  This activates the flow item and allows you to position it wherever you wish by clicking inside the flowchart sub-window.  After you have placed it on the flowchart sub-window, you may click-and-drag the item anywhere you wish to reposition it.  You can place as many copies of a step in a flow as you desire. 

Once you have your processing steps in a flowchart document, you may then select the linking tool from the tool palette and connect the steps together. You draw straight lines from one step to the next and thereby create the data flow between the [image: image246.png]FE SeisViewer
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processes. Each data step item can output a maximum of six links. 
Drawing Links
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Each link is type-checked for validity at the time you draw the link.  If an improper association is made, either directionally or sequentially, an error message will appear, and the link will not be completed.  For example, if you attempt to make a link from the Geometry Definition step to an SPS survey file in the above example, the following error message will appear:

Setting Processing Step and Data Step Parameters

To set the parameters for a processing step, you double click with the left mouse button on the step. Alternatively, you may set the parameters by highlighting the processing step with a single click of the mouse button and then selecting Parameters… from the Display menu.  This will display the dialog for setting the processing step parameters. Each dialog contains the parameters specific to that step. These parameters are set using numeric data entry fields, radio button controls, check boxes and drop down list boxes.
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A Step Parameter Dialog

Displaying Data Spreadsheets

To display a spreadsheet of trace headers associated with a seismic data set or the numeric values associated with a card data file, first select a data icon in the flow chart.  
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Select a Data File for Spreadsheet Display

Next, issue the Spreadsheet command from the Display menu. To achieve the same results faster, double-click on the data item using the right mouse button.
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  A Spreadsheet of Seismic Trace Headers

Spreadsheet Controls

<<   — This button on the spreadsheet moves to the first sheet in a multiple sheet spreadsheet.

<       — This button on the spreadsheet moves back (down) one sheet in a multiple sheet spreadsheet.

>       — This button on the spreadsheet moves forward (up) one sheet in a multiple sheet spreadsheet.

>>   — This button on the spreadsheet moves to the last sheet in a multiple sheet spreadsheet.
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A card data spreadsheet and the associated spreadsheet controls

Spreadsheet Commands
Add Row  — This button adds a row to the spreadsheet.  To quickly add multiple rows to a spreadsheet, hold down the Ctrl button when clicking on the Add Row button and the following dialog window will appear:
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Simply enter the total number of rows you desire. 

Del Row  — This button deletes the currently selected rows from the spreadsheet. Rows are selected by clicking on the row number at the left of the display.

Add Sheet – This button adds a new sheet to a multi-sheet spreadsheet.

Del Sheet – This button deletes the current sheet from a multi-sheet spreadsheet.

Cell Math – This command brings up the following dialog. The operations in the dialog are performed on the selected fields in the spreadsheet.  You can select entire columns by clicking in the column name at the top of the spreadsheet.
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Cell Math Dialog

Running the FlowChart

Once you are satisfied with the flow you have constructed, you must do three things to obtain results. 

· Name and Save the Flow

· Compile the Flow

· Execute the Flow

Naming and Saving a Flow

First, you must give the flow a name and save it. To name a flow document, use the Save… or the Save As… commands in the File menu. This allows you to browse for the directory location where you wish to save the flow and assign a meaningful name to the flow document.
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Save As FlowChart dialog

If you try to compile or execute a job that has not been named and saved, the Save as FlowChart dialog will automatically appear and you will be prompted to give the flow chart a name.  If you do not give the flow chart a name the following error message will appear:
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Un-named Flow error

Executing a Flow – Serial Mode
To execute a processing flow in Serial mode, select the Compile and Run command from the Flowchart menu.  Selection of the Compile and Run command will launch the Executor DOS window and result in the compiled flow chart being directly executed by the Executor.  The Compile and Run command allows execution of one flow per command.  If more than one processing segment is selected, where a segment is defined as the processes between an input file and an output file, then those segments will be executed sequentially.  The Executor Dos window automatically closes following completion job flow execution.
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The Compile and Run command

Executing a Flow – Parallel Mode
To execute a processing flow in Parallel mode, select the Compile command from the Flowchart menu.  Selection of the Compile command will generate a binary file (.cpf) is written to the target directory specified in the Preferences dialog that is accessed under the Edit menu.  The binary file will be picked up by the Job Manager for execution when computer resources are available.  You may compile the entire flow chart by selecting no steps on the flow or you may compile only a portion of the flow by selecting a single step or a few steps on the flow chart.
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Compile a Flow

Viewing the Statistics of an Executed Flow
Once the compiled flow chart has been successfully executed, a report of the execution is output as a file in the target directory. These files will have the name of the flow chart with a .console extension.  You may directly access these files by selecting Execution Console from the Flowchart menu.
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Accessing the Execution Console command
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View of a report of an executed flow with the .console extension.

 Encountering Errors in Execution
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If there are errors in the way you constructed your flow chart, they may not appear until you execute the job.  Your console may indicate that the compile ended without detecting any errors, such as the normal compile you see below.

FlowChart Console Contents
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However, the Executor may pick up the job and fail to finish.  If this happens, you may not receive an error message.

Executor Console Contents

Notice in the above Executor console, that the job has hung during the main phase of execution.  No errors are reported.  The job activity has ceased.  And there is no message indicating job completion.

At this point you must close the Executor. You may then compile and execute the job again, once you have found and corrected the error.  If you have difficulty finding and correcting the error, Parallel Geoscience Corporation has technical support available to assist you (support@parallelgeo.com).
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If the job executes successfully, you will observe the “Execution completed…” message at the bottom of the Executor window. The Executor window will automatically close at the end of execution
Execution Completed in Executor

Templates  

Flowchart templates are read-only files that were designed to serve as examples of the most common processing flows.  A text file accompanies each FlowChart processing template that explains the purpose of the flow, indicates how to use the flow, and describes the inputs and outputs required by the flow. Several templates have been created for each of the following processing categories:

· Input-output

· Geometry

· Filtering

· Velocities

· Statics

· Stacking

· Example Processing Flows

A zip file (Templates.zip) containing a complete range of FlowChart and SeisViewer templates is available as a free download from the Parallel Geoscience web site at:

ftp.parallelgeo.com/SPW_Products/Windows/Beta_Release/
The path name of each file in Templates.zip is specified relative to the pgc directory, which by default is C:\Program Files\pgc.  Therefore, if you will want to extract the entire contents of the zip file to the C:\Program Files\pgc directory.   The next few pages will explain how to access and implement the template for the application of:

1) 2D land geometry
2) 3D land geometry

3) Simple 2D marine geometry

4) 2D marine geometry with P1 90 location files and observer notes
Example Template: 2D Land Geometry Application

To access the 2D Land Geometry template, select Open Templates from the File menu.
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Step 1: select Open Template… from the File menu.

Selection of the Open Templates… will launch a dialog box that will prompt you to select a particular template.    
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The FlowChart template directory.

We are looking for the processing template that applies 2D-trace header geometry, so we will open the Geometry subfolder.

[image: image55.png]5] simple Marine Geometry. tmf
[Bukooa Marine Geometry.tmf





The Geometry templates.

Select the file 2D Geometry Application.tmf, which is the FlowChart template file (*.tmf) for the application of 2D Geometry.  A processing flow and its accompanying text file will open on the screen.
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[This text file accompanies the Flowchart template 20 Geometry Application.tmf
and contains information on the use of that template, Flowchart templates are
read-only files that were designed to serve as examples of executable processing
flows, Although templates are read-only files that cannot be changed or
executed, they may be renamed and saved to another location for use with your
data. fter saving the template to an executable file (.f10), any seismic or
card’data files associated with the flow can be renamed and the new Flow file
can be executed.

Flowchart template: 20 Geometry Application.tnf

Purpose: To update the seismic trace header with 20- acquisition

geometry information contained in the survey sps files.

nputs: spw formatted data file containing raw field files

Source sps card data file

Receiver SpS card data file

Cross-reference sps card data file

outputs: formatted data file with geometry updated trace

headers.

usage: (1) Use save As... from the File menu to maneuver
through your directory structure to a location
where you will save the Flowchart template as an
executable Flowchart file (.f10) with your own
file name.

(2) call your input data set into your new flow by
double-clicking on the input seismic file icon

(3) call the sps card data files into your new flow
by double-cTicking on the appropriate card data
file icons.

(4) Provide a name for your output data file by
double-clicking on the output seismic File icon

(5) select the Geometry befinition step by clicking
Snce on Te's icon so that it 45 mighiighted
in blue).

(6) select Compile and Run from the Flowchart menu

If you need any help, please contact support@parallelgeo. com.
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The processing flow 2D Geometry Application.tmf and the accompanying text file.

FlowChart templates, such as 2D Geometry Application.tmf are read-only files that can be neither altered nor executed.  However, you may use the file by saving it as a new file and assigning the appropriate inputs and outputs.  In the case of 2D Geometry Application.tmf, this would involve saving the file to a new directory (i.e. C:\My Project) and assigning the file a new name (i.e. 2D Geometry Application.flo).  You would then associate a data file with the input by double-clicking on the input icon and using the Browse button to locate the input data set.  File names are assigned to the output data file and the three SPS geometry files in a similar manner.  Once the FlowChart file has been renamed and each of the inputs and outputs has been assigned, the file is ready for execution.

Example Template: 3D Land Geometry Application
To access the 3D Land Geometry template, select Open Templates from the File menu.
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Step 1: select Open Template… from the File menu.

Selection of the Open Templates… will launch a dialog box that will prompt you to select a particular template.    

[image: image58.png]P —

% [E2Example Processing Fiows.
(©Fitering
My Recert | [ Geometry
Documents || Individual Flow Chart Summaries
(Dmput-output
B &=
Deskiop | |EDStack

Dstatis
% (@Testing
5| e
My Documerts
My Computer

€ e |

My Nk | Flsofbpe:[les Con)





The FlowChart template directory.

We are looking for the processing template that applies 3D-trace header geometry to land data, so we will open the Geometry subfolder.
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The Geometry templates.

Select the file 2D Geometry Application.tmf, which is the FlowChart template file (*.tmf) for the application of 2D Geometry.  A processing flow and its accompanying text file will open on the screen.
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[This text file accompanies the Flowchart template 3 Geometry Application.tmf
and contains information on the use of that template, Flowchart templates are
read-only files that were designed to serve as examples of executable processing
flows, Although templates are read-only files that cannot be changed or
executed, they may be renamed and saved to another location for use with your
data. fter saving the template to an executable file (.f10), any seismic or
card’data files associated with the flow can be renamed and the new Flow file
can be executed.

Flowchart file name: 30 Geometry Application.tmf

Purpose: To_update the seismic trace header with 3p acquisition geometry
infromation contained in the survey sps files.

nputs: spw formatted file containing raw field files
Source sPS file
Receiver sps file
Cross-reference sps file
The X, coordinates of three corners of the seismic acquisition grid

formatted file with geometry updated trace headers.

Use save As... from the File menu to maneuves
through your directory structure to a location
where you will save the Flowchart template as an
executable Flowchart file (.f10) with your own
file name.

(2) call your input data set into your new flow by
double-clicking on the input seismic file icon

(3) call the sps card data files into your new flow
by double-cTicking on the appropriate card data
file icons.

(4) Provide a name for your output data file by
double-clicking on the output seismic File icon

() select the ceometry pefinicion step by clicking
once on it’s icon (so that it is highlighted
in blue).

(6) select Compile and Run from the Flowchart menu

If you need any help, please contact support@parallelgeo. com.
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The processing flow 3D Geometry Application.tmf and the accompanying text file.

FlowChart templates, such as 3D Geometry Application.tmf are read-only files that can be neither altered nor executed.  However, you may use the file by saving it as a new file and assigning the appropriate inputs and outputs.  In the case of 2D Geometry Application.tmf, this would involve saving the file to a new directory (i.e. C:\My Project) and assigning the file a new name (i.e. 3D Geometry Application.flo).  You would then associate a data file with the input by double-clicking on the input icon and using the Browse button to locate the input data set.  File names are assigned to the output data file and the three SPS geometry files in a similar manner.  Once the file has been renamed and each of the inputs and outputs has been assigned, the file is ready for execution.

Example Template: Simple 2D Marine Geometry Application 

To access the Simple Marine Geometry template, select Open Templates from the File menu.
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Step 1: select Open Template… from the File menu.

Selection of the Open Templates… will launch a dialog box that will prompt you to select a particular template.    
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The FlowChart template directory.

We are looking for the processing template that applies trace header geometry to marine data, so we will open the Geometry subfolder.
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The Geometry templates.

Select the file Simple Marine Geometry.tmf, which is the FlowChart template file (*.tmf) for the application of Simple Marine Geometry.  A processing flow and its accompanying text file will open on the screen.
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read-only files that were designed to serve as examples of executable processing
flows, Although templates are read-only files that cannot be changed or
executed, they may be renamed and saved to another location for use with your
data. fter saving the template to an executable file (.f10), any seismic or
card’data files associated with the flow can be renamed and the new Flow file
can be executed.

I <unTITLED>
Flonchart template: simple Marine Geometry.tnf

Purpose: To_update the seismic trace header of a single-cable marine < }g;!
information about the acquisition geometry. i
input.spw
Inputs: sPu formatted file containing raw field files.
Streamer definition file,
Source sps file (optional).
Observer sps file (optional).

outputs: formatted data file with geometry updated trace
headers.

usage: (1) Use save As... from the File menu to maneuver

through your directory structure to a location
where you will save the Flowchart template as an
executable Flowchart file (.f10) with your own . &
e hanes e Geometry Streamer Definition

(2) call your input data set into your new flow by
double-clicking on the input seismic file icon.

(3) call the streamer pefinition card data file into
yournew “Flou by double-clicking on the card data
e icon

(4) optionally, call the sps card data files into
your new ~flow by double-clicking on the appropriate
card data File jcon.

(5) Provide a name for your output data file by
double-clicking on Tthe output seismic File icon.

(5) Select the simple Marine Geometry step by q
clicking once on it’s icon (so that it 15 &

it

mgnighed in b1ue) geometry updated output.spw

(6) sefect compile and Run from the Flowchart menu.

If you need any help, please contact support@parallelgeo.com. |
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The processing flow Simple Marine Geometry.tmf and the accompanying text file.

FlowChart templates, such as Simple Marine Geometry.tmf are read-only files that can be neither altered nor executed.  However, you may use the file by saving it as a new file and assigning the appropriate inputs and outputs.  In the case of Simple Marine Geometry.tmf, this would involve saving the file to a new directory (i.e. C:\My Project) and assigning the file a new name (i.e. Simple Marine Geomety.flo).  You would then associate a data file with the input by double-clicking on the input icon and using the Browse button to locate the input data set.  File names are assigned to the output data file and the three SPS geometry files in a similar manner.  Once the file has been renamed and each of the inputs and outputs has been assigned, the file is ready for execution.

Example Template: UKOOA Marine Geometry Application 

To access the UKOOA Marine Geometry template, select Open Templates from the File menu.
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Step 1: select Open Template… from the File menu.

Selection of the Open Templates… will launch a dialog box that will prompt you to select a particular template.    
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The FlowChart template directory.

We are looking for the processing template that applies trace header geometry with UKOOA files, so we will open the Geometry subfolder.
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The Geometry templates.

Select the file UKOOA Marine Geometry.tmf, which is the FlowChart template file (*.tmf) for the application of UKOOA Marine Geometry.  A processing flow and its accompanying text file will open on the screen.

[image: image68.png]8 Flowchart

') UKOOA Marine Geometry. txf - Notepad

Fle Edt Fomat Vew Hep

and contains_information on

can be executed.
Flowchart template:

Inputs: @
@

@

outputs: B

Usage: €8]

s
@

@

[©)
[©)

®

This text file accompanies the Flowchart template Simple Marine Geometry.tnf,

the use of that template, Flowchart templates are

read-only files that were designed to serve as examples of executable processing
flows, Although templates are read-only files that cannot be changed or
executed, they may be renamed and saved to another location for use with your
data. fter saving the template to an executable file (.f10), any seismic or
card’data files associated with the flow can be renamed and the new Flow file

UKOOA Marine Geometry. tmf

Purpose: To_update the seismic trace header of a single-cable marine survey with
information about the acquisition geometry.

spw formatted file containing raw field files.

P1/90 Navigation file with Source (mandatory) and Receiver

(optional) coordinate information.
observer sps file (optional).

formatted data file with geometry updated trace

headers.

Use save As... from the File menu to maneuves
through your directory structure to a location
where you will save the Flowchart template as an
executable Flowchart file (.f10) with your own
file name.

call your input data set into your new flow by
double-clicking on the input seismic file icon.
call the streamer Definition card data file into
yournew “Flou by double-clicking on the card data
e icon

optionally, call the sps card data files into

your new ~flow by double-clicking on the appropriate
card data File jcon.

Provide a name for your output data file by
double-clicking on Tthe output seismic File icon.
select the simple Marine Geometry step by

clicking once on it’s icon (so that it s
highlighted in blue).

sefect Compile and Run from the Flowchart menu.

If you need any help, please contact support@parallelgeo. com.
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The processing flow UKOOA Marine Geometry.tmf and the accompanying text file.

FlowChart templates, such as UKOOA Marine Geometry.tmf are read-only files that can be neither altered nor executed.  However, you may use the file by saving it as a new file and assigning the appropriate inputs and outputs.  In the case of Simple Marine Geometry.tmf, this would involve saving the file to a new directory (i.e. C:\My Project) and assigning the file a new name (i.e. UKOOA Marine Geomety.flo).  You would then associate a data file with the input by double-clicking on the input icon and using the Browse button to locate the input data set.  File names are assigned to the output data file and the three SPS geometry files in a similar manner.  Once the file has been renamed and each of the inputs and outputs has been assigned, the file is ready for execution.

SeisViewer
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SeisViewer is an interactive seismic data display, montage and plotting application.  SeisViewer is the display component of the SPW seismic processing system.  It is also stand-alone application capable of displaying SPW and SEGY formatted data files.  In contrast to most seismic display and plotting programs, SeisViewer allows you to completely customize your seismic display rather than forcing you to use a predefined template. The flexibility of the SeisViewer interface may require a slightly longer learning process but it provides you with a significantly more powerful set of tools.

A typical SeisViewer Canvas.

This SeisViewer introduction will guide you through the use of these drafting elements and the procedures necessary to build a simple seismic display.  If you are already familiar with the basic elements of SeisViewer you can skip the introduction and proceed directly to your topic of interest. The remainder of the manual is divided in to five sections: (1) A description of the Layer Tables; (2) A description of each of the SeisViewer commands; (3) A description of each of the SeisViewer display types; (4) A description of the processing capabilities found in SeisViewer; (5) A description of specific applications ideally performed in SeisViewer.

Introduction

SeisViewer opens with a blank canvas on which you place drafting elements to create a display of your work. The Add View toolbar in the upper left corner of the canvas contains a list of elements that can be placed on the canvas.
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A blank SeisViewer Canvas 

Add View Toolbar
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The Add View toolbar appears on the blank canvas when SeisViewer opens.  You may move it by clicking on the black bar at the top and dragging it to the desired location.  To remove it, click the close button located in the upper left corner.

Add View toolbar

The drafting elements on the Add View toolbar may be selected by clicking once to activate the element, and then pointing and clicking to position the subview.  If you point, click, and drag, you can determine the size of the element as you position it.  You may resize an element at any time by placing the cursor on any corner of the element and pushing or pulling it.  You can tell you have the cursor positioned properly when you see it change from a one-way arrow to a diagonal two-way arrow.  To reposition the element, place the cursor on any side of the element, where the cursor will change from a one-way arrow to a four-way arrow, and then drag the element to the desired position.

The first button on the Add View toolbar is the Select View button, which is graphically represented by a bold diagonal arrow.  This button is used to set the cursor for typical mouse functions, such as pointing and clicking for single element selection, and clicking and dragging for area selection.  It is also used for moving and resizing [image: image264.png]oK Apply Restore | Cancel
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objects or subviews.  It may even be used for scrolling within a subview.

Select View button
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The second button on the Add View toolbar is the Add Seismic Bitmap button. It is readily distinguished by a seismic wiggle.  The Add Seismic Bitmap button is the first one we will need to create a seismic display.  

Seismic Bitmap button

The thrid button on the Add View toolbar is the Add Grid button. It is readily distinguished by a grid of horizontal and vertical lines.  The Add Grid button is used to create displays of gridded data, such a velocity fields, FK spectra, and semblance spectra.  
[image: image69.bmp]
Grid button
The forth button on the Add View toolbar is the Add Horizontal Annotation button. It is distinguished by a hatched horizontal line.    The Add Horizontal Annotation tool in the Add View dialog is used place horizontal annotations on the canvas.
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The Add Horizontal Annotation button
The fifth button on the Add View toolbar is the Add Vertical Annotation button. It is distinguished by a hatched vertical line.    The Add Vertical Annotation tool in the Add View dialog is used place vertical annotations on the canvas.
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The Add Vertical Annotation button
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To activate the Add Seismic Bitmap tool, move the cursor to the Add Seismic Bitmap button and click on it with your left mouse button.  Once the Add Seismic Bitmap tool is activated, move your cursor anywhere on the open canvas, hold down the left mouse button, and scroll out a window that will contain the seismic data you wish to display.  As soon as you release the mouse button, the Seismic Display dialog will appear showing the menu that is located under the File tab.

Seismic Display dialog.

Seismic Display dialog
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The Seismic Display dialog allows you to (1) select the format of the data files you wish to display; (2) select the name of the data files you wish to display; and (3) customize the display parameters of the data file.  This is achieved through a collection of seven menus within the Seismic Display dialog.
The Seismic Display dialog
File menu
The File menu of the Seismic Display dialog provides functions for (1) selecting a seismic file to display in SeisViewer, (2) selecting the format of the seismic file to be displayed, (3) selecting the name and type of pick file for interactive picking in SeisViewer, and (4) setting the sort keys to determine the type of gather to display in SeisViewer. 
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File menu of the Seismic Display dialog.

SeisViewer displays both SPW and SEGY formatted data files.  To select the file format of the data file, scroll through the drop down menu located to the right of the words File format. To select the name of the seismic data file, click on the Seismic… button near the upper left-hand corner of the Seismic Display dialog.  The Open Data Set dialog will appear.
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Open Data Set dialog used to select a seismic file.

The Open Data Set dialog allows you to maneuver through the directory structure and select the data file you wish to display.  Once selected, the name and the path of this file will appear immediately to the right of the Seismic… button.  If you attempt to select an SPW formatted file with the File Format selection set to SEGY, the following [image: image270.png]oK Apply Restore | Cancel

Fie |t |[ Veris ][ seaing [ Pitsie || Ammaten | Pracess

Sei

CAData\GMGDatal Geomety.sgy.

Fileformat  [SEGY Default Format < F Customize...

Picks... | (none)
Filefomal [First Break Times -] options... | Help...

Sortkeys

Key Nametunits Header field index

Primay  [CDP/cdps  |CDP number k|
Secondary | [none) =
Tertiary ‘Oﬂseilﬁ [oftset |




error message will appear:
Error Message: File Extension and Format Mismatch
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A correctly selected, SPW formatted data file.
The selected seismic file may have been written to disk in a variety of sort orders.  SeisViewer attempts to display the data based on the order of the file has been written to disk.  Display order is established by setting up to three sort keys, which are found in the bottom half of the File tab.  To set the sort order for displaying your seismic data, configure the Primary, Secondary, and Tertiary Sort keys in the lower half of the Seismic Display dialog.  Each of these sort keys is set by scrolling through a drop down menu located to the right of the particular sort key.  In the following example, we will see one of many possible configurations for the display a 2D seismic data: field file order.  To display pre-stack seismic data in field file order, the sort keys should be set to Primary: Field File Number; Secondary: None; Tertiary: Channel.

Horz Axis menu
To set or review the horizontal display parameters for the seismic display, click on the Horz Axis menu in the Seismic Display dialog.  The Horizontal Axis menu displays all of the information relevant to (1) the spatial range of seismic data that will be displayed in the Seismic Bitmap subview, and (2) the horizontal size and scaling of the seismic data that will be displayed in the Seismic Bitmap subview.  As it is configured in the figure below, the Horizontal Axis menu indicates that the Seismic Bitmap subview will contain seismic traces from a range of Field Files (e.g. FFID 386 – 485), each of which contain 105 channels file.  The horizontal trace spacing can be adjusted by entering the desired value in the Horizontal scale parameter entry box.  Larger numbers in the Horizontal scale box decrease the distance between traces plotted in SeisViewer.  Smaller numbers in the Horizontal scale box increase the distance between traces plotted in SeisViewer.
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The Horizontal Axis menu

Vert Axis menu
To set or review the vertical display parameters for the seismic display, click on the Vert Axis menu in the Seismic Display dialog.  The Vert Axis menu displays all of the information relevant to (1) the temporal range of seismic data that will be displayed in the Seismic Bitmap subview, and (2) the vertical size and scaling of the seismic data that will be displayed in the Seismic Bitmap subview.  The Vert Axis menu allows you to set the start time of the displayed seismic data, the range of recording times to plot, the timing line increment, and the line style of timing lines.  As it is configured in the figure below, the Vert Axis menu indicates that the Seismic Bitmap subview will contain the full trace length (e.g. 1500 samples of 2ms data for a trace length of 2998ms) of the data file selected under the File tab.  The vertical scale can be 
adjusted by entering the desired value in the Vertical scale parameter entry box.  .  Larger numbers in the Vertical scale box increase the length of the traces plotted in SeisViewer.  Smaller numbers in the Vertical scale box decrease the length of traces plotted in SeisViewer.
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The Vertical Axis menu 
Scaling menu
To set or review the scaling parameters for the seismic display, click on the Scaling menu in the Seismic Display dialog.  The Scaling menu displays all of the information relevant to the scaling of the seismic data that will be displayed in the Seismic Bitmap subview.  Scaling options include true amplitude, relative amplitude, and AGC.  The true and relative amplitude scalars can be computed from the full trace length or a selected time window of the data file.  As it is configured in the figure below, the Scaling menu indicates that each trace in the Seismic Bitmap subview will be scaled independently, according the maximum value found in the trace.
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The Scaling menu 
 .

Plot Style menu
To set or review the trace plotting parameters for the seismic display, click on the Plot Style menu in the Seismic Display dialog.  The Plot Style menu displays all of the information relevant to the style in which each of the seismic trace will be displayed in the Seismic Bitmap subview.  Trace plotting options include wiggle trace, variable area, variable area with wiggle trace, and variable density.  The variable density display allows you the option of selecting one of several color palettes included with the software or of importing one of your own.  As it is configured in the figure below, the Plot Style menu indicates that the selected seismic data will be plotted as variable area wiggle traces.
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The Plot Style menu

When you are satisfied with the preliminary plotting parameters that have been set under each of the previously described menus, click on the OK button in the upper left corner of the Seismic Display dialog.  The seismic file you selected for display will now appear on the canvas.

Animation menu
The functions on the Animation menu are used to (1) control the rate of scrolling, (2) display additional trace header information in the bottom left corner of the SeisViewer application.  As it is configured in the figure below, the Animation menu indicates that the selected seismic data will be plotted as variable area wiggle traces.
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The Animation menu

When you are satisfied with the preliminary plotting parameters that have been set under each of the previously described menus, click on the OK button in the upper left corner of the Seismic Display dialog.  The seismic file you selected for display will now appear on the canvas.

Process menu
The Process menu is used to perform interactive single-channel processing on the seismic data displayed in SeisViewer.  This is for display purposes only.  The displayed seismic file will not be altered in any way.  To perform a process on the selected seismic file, simply select a processing step from the Process type scoll down menu and configure the appropriate parameters.
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The Process menu

Display

When you are satisfied with the preliminary plotting parameters that have been set under each of the previously described menus, click on the OK button in the upper left corner of the Seismic Display dialog.  The seismic file you selected for display will now appear on the canvas.
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Bitmap display of a single 2D field file.

Horizontal annotation

To annotate the horizontal or the vertical axes of this display, we need to select the appropriate tools from the Add View dialog.  The Add Horizontal Annotation tool in the Add View dialog is used place horizontal annotations on the canvas.

[image: image271.png]Fle Edt AddView Step View Picking Drawing Window

50 70

Frequency ih

Hep

FK Spectrum
Location 101

Wave number (x103)

FIC Ampitus

00

EEE

Frequency 148.313 Wavenumber 0.0157 Amplitude -108.091





The Add Horizontal Annotation button

To activate the Add Horizontal Annotation tool, move the cursor to the Add Horizontal Annotation button and click on it with your left mouse button.  Once the Add Horizontal Annotation tool is activated, move your cursor to the upper left corner of the seismic display selected for annotation and you will see the cursor change from an arrow to a corner frame.  
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Placement of the Add Horizontal Annotation tool

At this point, click the left mouse button and the horizontal annotation sub-window will appear.
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2D seismic field file with horizontal annotation.

Vertical annotation

The Add Vertical Annotation tool in the Add View dialog is used place vertical annotations on the canvas.
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The Add Vertical Annotation button

To activate the Add Vertical Annotation tool, move the cursor to the Add Vertical Annotation button and click on it with your left mouse button.  Once the Add Vertical Annotation tool is activated, move your cursor to the upper left corner of the seismic display selected for annotation and you will see the cursor change from an arrow to a corner frame.
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Placement of the Add Vertical Annotation tool

At this point, click the left mouse button and the vertical annotation sub-window will appear.
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2D seismic field file with vertical and horizontal annotation.

Reposition or Resize a seismic display
To reposition the seismic display place the cursor on any of the four edges of the current display such that the cursor changes to a four-way arrow.  To resize the seismic display, place the cursor on any of the four corners of the current display such that the cursor changes to a diagonally oriented two-way arrow.

[image: image273.png]F-K Spectru

Trace Amplitude Definition
€ Use relative amplitude traces

@ Use true amplitude traces.

Extended K Space
I” Extend the trace (k) dimension

DB Scale Control

I Use this value as the 0 dB value

o

T =

FK Spectrum

Output

 Amplitude & dB down

Output Min-Max
I” Range I

it the output using:

i
i

Line number [1
Cancel




[image: image274.png]Spherical Divergence Correction
by

I Divergence Corre

jer * (Time * T_Exponent) *
ier * ( Velocity * V_Exponent)

Time Multiplier [1.00
Time Exponent [2.00
Velocity Multiplier [1.00
Velocity Exponent [2.00

I™ Apply inverse function

Cancel





Reposition the seismic display.                                         Resize the seismic display.
Trace Header plots
To add additional trace header annotation, such as the receiver elevation, we will use the Add Header Plot tool in the Add View dialog.  The Add Header Plot tool in the Add View dialog is used to create plots of trace header values on the canvas.
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The Add Header Plot button

To activate the Add Header Plot tool, move the cursor to the Add Header Plot button and click on it with your left mouse button. Once the Add Header Plot tool is activated, move the cursor to the lower left corner of the seismic display selected for annotation, click once, and the header plot sub-window will appear. 
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Placement of an Add Header Annotation window
.

The Header Plot sub-window will remain empty until a trace header value is selected for display.  To select a value, double-click in the highlighted header plot window and the Seismic Header Plot Display dialog will appear.  The Seismic Header Plot Display dialog allows you to select the trace header values for annotation as well as control the format of the displayed trace header information.
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Seismic Header Plot Display dialog.

One of the first things you should notice in the Seismic Header Plot Display dialog is that the seismic file from which the dialog will extract trace header information is the same as that selected in the Seismic Display dialog.  In other words, we are plotting header values for the seismic data that is currently displayed.  Second, the configuration of the sort keys in the Seismic Header Plot Display dialog should be identical to those set in the Seismic Display dialog.

To select the trace header value that will be annotated on the seismic display, click on the Vert Axis menu.  The Vert Axis menu contains a drop down menu that you can scroll through to select the trace header field that will be annotated.  In this case, we will select Receiver Elevation.
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Selecting Receiver Elevation from the Header field list.
After selecting the header field to annotate, click on the OK button in the upper left of the Seismic Header Plot Display dialog and the trace header annotation sub-window will appear.  Vertical annotation can be added to the header plots in the same manner that they are added to seismic bitmap displays.
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2D seismic field file with horizontal, vertical and trace header annotation.
Save 
Once the SeisViewer canvas contains all of the information required in your seismic display, you will want to save the canvas.  This is a simple matter of selecting the Save Canvas command under the File menu.  At this point the Enter Output Canvas Filename dialog will appear.   
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Selecting Save Canvas from the File menu.
The Enter Output Canvas Filename dialog allows you to maneuver through the file structure, select an output directory for the SeisViewer canvas, and assign a file name to the SeisViewer canvas.  Once selected, the file name of the SeisViewer canvas will appear in parenthesis immediately to the right of the SeisViewer icon located in the upper left corner of the SeisViewer display.  The .can extension is automatically appended to the chosen file name.
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Name a Seisviewer canvas file with the Enter Output Canvas Filename dialog.
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Saved SeisViewer Canvas

The saved SeisViewer file contains all of the display parameters that were set during creation of the canvas.  Therefore, to view the same seismic display in the future, simply select Open Canvas from the File menu and select the appropriate SeisViewer canvas file name.  

Use the scroll keys on your keyboard to scroll through each of the field files in the selected data set.  The up arrow will step forward one field file at a time, and the down arrow will step backward one field file at a time.

This concludes the SeisViewer introduction.  You should now have an elementary understanding of how seismic displays are created in SeisViewer.

Layer Table
In order to increase the flexibility of the seismic display, each subview in a SeisViewer canvas is treated as an individual layer.  For example, the final canvas in the SeisViewer introduction consisted of eight layers: (1) a seismic bitmap; (2) a horizontal annotation for the seismic bitmap; (3-4) two vertical annotations for the seismic bitmap; (5) a trace header plot; (6-7) two vertical annotations for the trace header plot; (8) a side label.  The Layer Table is designed to centralize control of all subview-related functions on the SeisViewer canvas.  First, it allows you to access and control each of the individual subview parameter dialogs.  Second, it allows you to access and control the spatial relationship between individual subviews.  Third, it allows you to establish links between individual subviews so that they will act separately or in unison.  An example will serve to demonstrate the utility of the Layer Table functions.
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The SeisViewer canvas in the figure below compares a 3D shot gather before (left) and after (right) the application of datum statics.  Each of the seismic displays is complete with horizontal, vertical, and trace header annotation. Each of these elements constitutes a layer on the canvas.  The Layer Table displays entries such as the file name, the data group, and the horizontal and vertical relationships existing among each of the subviews.  The remainder of this chapter will describe the information content of the Layer Table associated with this canvas as well as the Layer Table commands used to modify the canvas’s appearance.  

Seismic display comparing a 3D shot gather before (left) and after (right) datum statics.

To access the Layer Table select Layer Table from the Window submenu.  The Layer Table will appear in the foreground, and the main menu on the top of the canvas will change from the SeisViewer menu to the Layer Table menu.
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Accessing the Layer Table
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The Layer Table (foreground) and the Layer Table menu (upper left corner).

A first look at the Layer Table presents the user with a spreadsheet of subview related information.  In this case, the type icons in the first column of the Layer Table indicate that there are two seismic bitmap subviews, two header plot subviews, two horizontal annotation subviews, and eight vertical annotation subviews.  Layer numbers in the second column of the Layer Table are assigned sequentially, in the order in which the subview appeared on the canvas. To select a subview or to identify the subview corresponding to any individual layer, simply select a layer in the Layer Table.  The corresponding subview will be highlighted with a cyan boarder.
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Identification of a layer with the corresponding subview.

Specific elements of the layer table for the shot gather comparison.

The next four sections will be dedicated to (1) defining each of the fields in the Layer Table spreadsheet; (2) describing each of the commands in the Layer Table menu; (3) describing the Layer Table Editing features; (4) describing the Layer Table Sorting features.  The final section will be an interpretation of the Layer Table contents for the SeisViewer canvas illustrated in the previous figures.

Layer Table Spreadsheet

Subview

Type

The icon denoting the type of subview is for information purposes only.  It cannot be changed or edited. A single mouse click on the icon will select the subview.  A double click will raise the parameter dialog for that subview.

Layer 

All subviews must have a layer number.  The layer value for a subview represents its placement in the canvas drawing order. Layer numbers are assigned sequentially, in the order in which the subview appears on the canvas.  A subview with a higher layer value can obscure one with a lower value if they overlap.  Editing the layer number is discussed under Editing Layer Table Items.

Name

The subview name is intended to be a unique name by which each specific subview may identified. Subview names are assigned alphabetically, in the order in which they appear on the canvas.  Editing of the subview name is not allowed. 

Data

Filename

The Filename lists the name of the data file associated with that subview. If no data file is opened for a subview, the Filename column will be empty. The filename corresponding to a particular subview may be changed in one of two ways. First, to change the data file corresponding to a Seismic Bitmap, a Header Plot, or the Horizontal or Vertical Axis subview of a Seismic Bitmap, double click on the Filename text to raise the file dialog page, where you may open a different data file or close the current one.  Second, to change the data file corresponding to a Drawing Image or Side Label subview, change the name of the data group to that of a subview associated with the desired data file.  Double clicking on the Filename of a Drawing Image or Side Label subview will only bring up its environment page, not a file dialog.  The name of the data file cannot be changed from the environment page. 

Group

Subviews belonging to the same data group are associated with the same data file.  Therefore, they will display information relating to the same data.

Scroll Group

The purpose of a scroll group is to allow synchronous horizontal or vertical movement either among subviews of an individual data group or among subviews of different data groups.

Horizontal

Seismic bitmap subviews that belong to the same horizontal scroll group will stay synchronized as any one of those subviews is stepped through by primary, secondary, or tertiary sort keys.  Subviews that belong to both the same data group and the same horizontal scroll group will change sorting parameters, horizontal scales, and vertical scales together. 

Vertical

Subviews that belong to the same vertical scroll group will stay synchronized when any one of the subviews is dragged or scrolled in the vertical direction.  They will also change vertical scales together. 

Edge Group

The purpose of an edge group is to allow simultaneous movement of all edges in that group in the same direction and by the same amount. When subviews are created such that they share a common boundary (i. e. "snap to" one another), those edges are automatically assigned to a common edge group.  When subviews are created such that they have an edge that would be common except for a small gap along the dimension perpendicular to those edges, those edges are also assigned to a common edge group.

Left

Subviews that share a common left edge group will move in unison.

Right

Subviews that share a common right edge group will move in unison.

Top

Subviews that share a common top edge group will move in unison.

Bottom

Subviews that share a common bottom edge group will move in unison.

Fixed Size
The fixed size fields Width and Height are toggle switches that change state between True and False with a single mouse click. These characteristics determine whether the width and/or the height of a subview will be preserved during a resize or a translation of the associated subview. Take the example of two side-by-side subviews that share a common border.  If Width is True for the right-hand subview, resizing the left-hand subview by moving the common border either left or right will not change the width of the right-hand subview. The right edge of the right-hand subview will move in the same sense and the same amount as the common boundary (its left edge), preserving the width of the right-hand subview.

Width
A value of True indicates that the width of the subview will be preserved during a resize or a translation of the associated subview. A value of False indicates that the width of the subview will not be preserved during a resize or a translation of the associated subview.

Height
A value of True indicates that the height of the subview will be preserved during a resize or a translation of the associated subview. A value of False indicates that the height of the subview will not be preserved during a resize or a translation of the associated subview.

Layer Table Menu

File Menu

Hide Window
Selection of the Hide Window command will hide the Layer Table window and bring the SeisViewer window into the foreground. 

Exit

Exit shuts down the SeisViewer application. If the current canvas is newly created, or canvas has been changed since it was last saved, a warning dialog will appear that asks you to save these files prior to shut down. 

Edit Menu

Select All Views

The Select All Views command will select all views contained in the SeisViewer window. (The highest layer will be designated as the current subview.) 

Delete View

The Delete Views command will delete all selected subviews.  A warning dialog will appear asking for verification. Once deleted, subviews cannot be retrieved unless they were saved previously to the existing canvas.  The Delete View command may also be accessed through the keyboard combination Crtl+Del.

View Menu

Hide Selected Views

The Hide Selected Views command will hide all selected subviews in the SeisViewer window. The subviews will still exist, and all of their settings will be preserved. The hidden subview will be listed in the Layer Table in grayed out text (or whatever color has been selected for "Hidden subview text" in the Preferences… dialog found under the Edit submenu.) 

Show Selected Views

The Show Selected Views command will reveal any hidden subviews that are selected in the Layer Table.  Hidden subviews are listed in the Layer Table in grayed out text (or whatever color has been selected for "Hidden subview text" in the Preferences… dialog found under the Edit submenu.) 

Opaque Background

The Opaque Background command is used to set all selected subview backgrounds opaque. When a subview has an opaque background, it will obscure all subviews that it overlays. By default, Seismic Bitmap and Side Label subviews are created with opaque backgrounds. 

Transparent Background

The Transparent Background command is used to set all selected subview backgrounds transparent. When a subview has a transparent background, any subviews that it overlays will be visible. By default, Drawing Image, Header Plot, Horizontal Annotation, and Vertical Annotation subviews are created with transparent backgrounds. 

Draw Border

The Draw Boarder command will draw a border for all selected subviews.  The border will be beveled for all subviews except Side Labels, which have a solid border.  Default colors for the beveled border are off white and gray, but these may be reset in the Preferences… dialog's found under the Edit menu. By default the Seismic Bitmap, Header Plot, Drawing Image, and Side Label subviews are created with a border. 

No Border

The No Boarder command will remove the border from all selected subviews. By default, Horizontal and Vertical Annotation subviews are created without a border. 

Window Menu

The Window Menu is used to access application windows other than the Layer Table window. (Currently only the SeisViewer and the Layer Table windows are available.) 

Canvas

This command will bring the SeisViewer window to the front of the window stack, and place the Layer Table in the background. 

Help Menu

About...

The About… command lists the SeisViewer version number and information about Parallel Geoscience Corporation.

Editing Layer Table Items

The elements in the Layer Table that may be edited are: the layer number, the data file name, the data group name, the two scroll group names, the four edge group names, and the states of the width and the height fields. The width and the height fields toggle between true and false with a single mouse click on the text.  To change the data file name corresponding to a Seismic Bitmap, a Header Plot, or the Horizontal or Vertical Axis of a Seismic Bitmap, double click on the Filename text to raise the file dialog page, where you may open a different data file or close the current one.  The values associated with a layer number, a data group, a scroll group, or an edge group may be edited manually or with the drag-and drop feature.

Manual Editing

To perform a manual edit, double click with the mouse on the target text. This will cause the row for that subview will be highlighted in cyan and the target text to be highlighted in white.  Edit the target text with the keyboard, making sure to input the value with the Enter key.

Drag-and-Drop Editing
Drag-and-drop editing is performed by selecting a desired value with the mouse and dragging it to the target element. When the mouse button is held down over a draggable element, the text background of that element will be highlighted in magenta. When the mouse is moved to a valid target location, the text of the target element will become highlighted in magenta.  To drop the dragged element into a highlighted target text location, simply release the mouse button and the target element will change to the value of the dragged element. 

Drag-and-drop editing of layer values, data group names, and scroll group names is only allowed in the same column as the target element.  Drag-and-drop editing the Right and the Left edge group names is allowed between the two columns. Drag-and-drop editing the Top and the Bottom edge group names is allowed between the two columns. Drag-and-drop editing is not allowed for Type icons, Subview names, Data Filenames, or the Width and Height fields.

Sorting the Layer Table

The Layer Table lists all the existing subviews of the canvas in a sorted order, each row of the table representing one subview. Initially the table is sorted by drawing order or "layer", denoted by the highlighted Layer button. When sorting by layer, the most recently added subview will be at the top of the table (that with largest layer value at the top of the stack), and the remaining subviews will be listed in decreasing layer value (toward the bottom of the stack.).  The Layer Table may be sorted by all fields with the exception of the Width and the Height fields. To sort the Layer Table according to a given field, simply depress the appropriate button at the top of the column with the mouse.  The column button will become highlighted. 

Reading a Layer Table

Now that the fields and the commands related to the Layer Table have been defined, we will quickly read the layer table in associated with the example.
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Example Layer Table.

The example Layer Table in the figure above consists of fourteen layers: two seismic bitmaps (1,8); two header plots (5,12); two horizontal annotations for the seismic bitmaps (2,9); four vertical annotations for the seismic bitmaps (3,4,10,11); four vertical annotations for the trace header plots (6,7,13,14).

The subviews on the SeisViewer canvas are associated with two seismic data files, RussPermGeom and RussPermDatum.  The RussPermGeom file consists of trace header updated field files prior to the application of datum statics, and the RussPermDatum file consists of trace header updated field files after to the application of datum statics.  These data files have been assigned the Group names A and I, respectively.

The two seismic bitmaps, the two trace header plots, and the two horizontal annotations for the seismic bitmaps are all assigned to Horizontal Scroll Group F.  This implies that as we step through the shot gather on the left (i.e. RussPermGeom), the shot gather on the right (i.e. RussPermDatum), each of the horizontal annotations, and the each of the trace header plots will advance in unison.  The same is true if we step through the shot gather on the right: the associated layers in the Horizontal scroll group will follow in unison.  Because we are comparing to sets of seismic data one shot gather at a time, this is exactly what we want.

The two seismic bitmaps and the four vertical annotations for those seismic bitmaps are all assigned to Vertical scroll group B.  This links both of the seismic data files and they’re corresponding vertical timing lines.  Dragging or scrolling any one of these layers in the vertical direction will result in an equal movement among the associated layers in the Vertical scroll group.

As the Layer Table is currently configured, each of the seismic bitmaps share an edge group with the horizontal annotations on their top edge, the trace header plots on their bottom edge, and the vertical annotations along each of their side edges.  In particular, the seismic bitmap in Layer 1, which is on the right side of the canvas, belongs to Left edge group D, Right edge group G, Top edge group C, and Bottom edge group E.  The horizontal annotation in Layer 2, which is on top of the seismic bitmap in Layer 1, belongs to Bottom edge group C.  Therefore, edge group C links the top edge of the seismic bitmap and the bottom edge of the associated horizontal annotation.  Working your way around the seismic bitmap in a clockwise direction, you will see that each edge of the seismic bitmap is linked to the adjacent layer through an edge group.  

As the Layer Table is currently configured there are vertical links between the two seismic bitmaps through Top and Bottom edge groups C and E.  In other words, if we were to move the shot gather display corresponding to the seismic bitmap in Layer 1 towards the top of the canvas, the shot gather display corresponding to the seismic bitmap in Layer 8 would follow.  However, there are no horizontal links between the two seismic bitmaps and their associated annotations.  In other words, if we were to move the shot gather display corresponding to the seismic bitmap in Layer 1 to the left, the shot gather display corresponding to the seismic bitmap in Layer 8 would not follow.  To link the two displays horizontally, we need to place their horizontal edges – the right edge of the vertical annotation in Layer 4 and the left edge of the vertical annotation in Layer 10 - in the same edge group.  To link the right edge of the vertical annotation in Layer 4 and the left edge of the vertical annotation in Layer 10 simply drag-and-drop Right edge group T in Layer 4 into Left edge group N in Layer 10.  The seismic bitmaps and their associated annotations are now linked sequentially, horizontally, and vertically.
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Selection of Right edge group T.
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Dragging Right edge group T to Left edge group N. 
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Dropping Right edge group T into Left edge group N.

The Width and Height fields state whether the size of a subview will remain fixed during a resize or a translation.  As the Layer Table is currently configured neither of the two seismic bitmaps nor the two header plots is set to be fixed during a resize or a translation.  The effect of these Fixed Size states is demonstrated by dragging the seismic display on the right of the canvas up and to the left.  The height/width ratio of the dragged canvas will remain unchanged during after translation.  However, the height/width ratio of the seismic display on the left and of the two trace header plots will be distorted by an amount proportional to the magnitude of translation.  In order to translate or resize the seismic display on the right without a corresponding [image: image285.png]1
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distortion of the other plots, simply toggle the height and width fields associated with the trace header plots and the seismic display on the left to “True”.

Grab the seismic display on the right and drag up and to the left.

Translation of the seismic bitmap on the right with “False” height and width [image: image286.png]Ok | apply Restore | Cancel
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fields for the seismic bitmap on the left and “False” height and width fields for the two trace header plots.
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Toggle each of the Width and Height fields associated with the trace header plots in Layers 5 and 12 and the seismic bitmap in Layer 8 to “True”.

Translation of the seismic bitmap on the right with “True” height and width fields for both seismic bitmaps and the corresponding trace header plots.
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Seismic Bitmap Displays

The Seismic Bitmap subview can display a variety of data formats, including the SPW internal format, several SEGY formats, and a headerless data format.  However, the SeisViewer architecture is optimized for the display and analysis of SPW formatted data.

SPW format is the data type output by any Flowchart job to a Seismic Data file.  These may include standard seismic data files (i.e. shot gathers, CMP gathers, stack sections, etc…), as well as autocorrelations, amplitude spectra, F-K spectra, and velocity cubes.   SEGY format is a common archive format for seismic data.  A headerless data format describes any data that consist purely of sample values without trace header information.

Seismic Bitmaps are displayed in SeisViewer by selecting the Add Seismic Bitmap icon from the Add View Toolbar and scrolling out a subview drawing area.  Once the subview window has been created a Seismic Display dialog will appear that will require the user to provide information concerning the File format and the Input file name.  If the input file is used to create a pick file, the user will also be require to provide information concerning the pick file format and the pick file name.

SPW Data
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To display SPW formatted data in a Seismic Bitmap subview display, activate the Add Seismic Bitmap tool.  The Add Seismic Bitmap tool is activated by clicking on the Add Seismic Bitmap button in the Add View Toolbar.  Alternatively, the Add Seismic Bitmap tool may be activated by selecting Seismic Bitmap under the Add View menu. 

The Add View Toolbar

Once the Add Seismic Bitmap tool is activated, move your cursor anywhere on the open canvas, hold down the left mouse button, and scroll out a window that will contain the seismic data you wish to display.  As soon as you release the mouse button, the Seismic Display dialog will appear showing the menu that is located under the File tab.
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Scrolling out a subview on the SeisViewer canvas.
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Seismic Display dialog
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The Seismic Display dialog allows you to (1) select the format of the data files you wish to display; (2) select the name of the data files you wish to display; and (3) customize the display parameters of the data file.  To display SPW formatted data, scroll through the drop down menu located to the right of the words File format and select SPW Format.  To select the name of the SPW file, click on the Seismic… button near the upper left-hand corner of the Seismic Display dialog.  The Open Data Set dialog will appear.  Use the Open Data Set dialog to browse through the directory structure and select the SPW file you wish to display.  The name of this file will appear to the right of the Seismic… button after it has been selected.  If you attempt to select a foreign file format (e.g. SEGY) with the File Format selection set to SPW, the following error message will appear:

Incorrect format error message
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Set the File format to SPW and select the appropriate SPW formatted data file.

The selected seismic file may have been written to disk in a variety of sort orders.  To set the sort order for displaying the seismic data, configure the Primary, Secondary, and Tertiary Sort keys in the lower half of the Seismic Display dialog.  Each of these sort keys is set by scrolling through the drop down menu located to the right of the particular sort key.  The following examples will illustrate the display of field files, common receiver gathers, and common midpoint gathers from a single SPW data file with fully updated trace headers.   

The sort keys in the figure above are set to Primary: Field File Number; Tertiary: Channel. This is standard sort order for the display of a field file.  To display the field file, simply click on the OK button in the upper left corner of the Seismic Display dialog.  Use the scroll keys to step through the field files.

Display of a SPW formatted field file without annotation.
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Use the Add Horizontal Axis and Add Vertical Axis tools to annotate the display with field file number, channel number, and two-way travel time.
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Annotated field file display.
To display the same data file as a series of common-receiver gathers, double-click on the seismic bitmap subview to open the Seismic Display dialog.  Set the sort keys to Primary: Receiver Location; Tertiary: Source-Receiver Offset. This is a standard sort order for the display of common-receiver gathers.  To display the common-receiver gather, simply click on the OK button in the upper left corner of the Seismic Display dialog.  The horizontal annotation will be updated accordingly.  Use the scroll keys to step through the common-receiver gathers.
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To display a common-receiver gather, set the Sort keys to Primary: Receiver Location; Tertiary: Source-Receiver Offset.
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Annotated common-receiver gather.
To display the same data file as a series of common-midpoint gathers, double-click on the seismic bitmap subview to open the Seismic Display dialog.  Set the sort keys to Primary: CMP Location; Tertiary: Source-Receiver Offset. This is standard sort order for the display of a common-midpoint gather.  To display the common-midpoint gather, simply click on the OK button in the upper left corner of the Seismic Display dialog.  The horizontal annotation will be updated accordingly.  Use the scroll keys to step through the common-midpoint gathers.
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To display a common-midpoint gather, set the Sort keys to Primary: CMP Location; Tertiary: Source-Receiver Offset.
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Annotated common-midpoint gather.
SEGY Data

To display SEGY formatted data in a Seismic Bitmap subview display, activate the Add Seismic Bitmap tool.  The Add Seismic Bitmap tool is activated by clicking on the Add Seismic Bitmap button in the Add View Toolbar.  Alternatively, the Add Seismic Bitmap tool may be activated by selecting Seismic Bitmap under the Add View menu. 
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Once the Add Seismic Bitmap tool is activated, move your cursor anywhere on the open canvas, hold down the left mouse button, and scroll out a window that will contain the seismic data you wish to display.  As soon as you release the mouse button, the Seismic Display dialog will appear showing the menu that is located under the File tab.
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Scrolling out a subview on the SeisViewer canvas.
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Seismic Display dialog
The Seismic Display dialog allows you to (1) select the format of the data files you wish to display; (2) select the name of the data files you wish to display; and (3) customize the display parameters of the data file.  To display SEGY formatted data, scroll through the drop down menu located to the right of the words File format and select SEGY Default Format.  To select the name of the SEGY file, click on the Seismic… button near the upper left-hand corner of the Seismic Display dialog.  The Open Data Set dialog will appear.  Use the Open Data Set dialog to browse through the directory structure and select the SEGY file you wish to display.  The name of this file will appear to the right of the Seismic… button after it has been selected.  If you attempt to select a non-SEGY file format (e.g. SPW) with the File Format selection set to SEGY Default Format, the following error message will appear:
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 Incorrect format error message
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Set the File format to SEGY Default Format and select the appropriate SEGY formatted data file.

The selected seismic file may have been written to disk in a variety of sort orders.  To set the sort order for displaying the seismic data, configure the Primary, Secondary, and Tertiary Sort keys in the lower half of the Seismic Display dialog.  Each of these sort keys is set by scrolling through the drop down menu located to the right of the particular sort key.  The following examples will  illustrate the display of field files, common receiver gathers, and common midpoint gathers from a data file with fully updated trace headers.   

The sort keys in the figure above are set to Primary: Source record Number; Tertiary: Offset. This is a standard sort order for the display of field files in SEGY format.  To display the field file, simply click on the OK button in the upper left corner of the Seismic Display dialog.  Use the scroll keys to step through the field files.

SEGY field file display without annotation.

[image: image305.png]FE SeisViewer

Fie Edt AddView Step View Picking Drawing Window Hep

PE SeisViewer Canvas ( next canvas.can )

[alal]

FK Spectrum
Locaton 101 Wave number (x103)
2400 B0 6 40 20 0 20 4

H
RN

g

g
ol T

H

Frequency ih

FK Spectrum
Locaton 101 Wave number (x103)
8070 60 50 40 30 20 10 0 10 20 30 40 50 60 70 &0

Frequency ih

Input Gather with Noise

o

Top - FK Spectum of Input
Bottom - FK Spectrum of Output

FK Filtered Gather

H

H

H

600

H

00

| Frequency 85.719 Wavenumber-0.0373 Amplitude -60.491





Use the Add Horizontal Axis and Add Vertical Axis tools to annotate the display with field file number, channel number, and two-way travel time.
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Annotated SEGY field file display.
To display the same data file as a series of common-receiver gathers, double-click on the seismic bitmap subview to open the Seismic Display dialog.  Set the sort keys to Primary: Receiver Group number; Tertiary: Offset. This is a standard sort order for the display of common-receiver gathers in SEGY format.  To display the common-receiver gather, simply click on the OK button in the upper left corner of the Seismic Display dialog.  The horizontal annotation will be updated accordingly.  Use the scroll keys to step through the common-receiver gathers.
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To display a common-receiver gather, set the Sort keys to Primary: Receiver group number; Tertiary: Offset.
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Annotated common-receiver gather in SEGY format.
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To display the same data file as a series of common-midpoint gathers, double-click on the seismic bitmap subview to open the Seismic Display dialog.  Set the sort keys to Primary: CDP number; Tertiary: Offset. This is a standard sort order for the display of common-midpoint gathers in SEGY format.  To display the common-midpoint gather, simply click on the OK button in the upper left corner of the Seismic Display dialog.  The horizontal annotation will be updated accordingly. Use the scroll keys to step through the common-midpoint gathers.
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To display a common-midpoint gather, set the Sort keys to Primary: CMP number; Tertiary: Offset.
Annotated common-midpoint gather in SEGY format.
Grid Displays

The Grid Display subview can display two types of grids: (1) SPW Grids that are generated in Flowchart as 'Image Data...' files, and (2) grids that are generated in SeisViewer from seismic data that has been output in a Flowchart processing flow.  Currently supported SPW Grid types are:



3D CMP Fold Image
3D CCP Fold Image
3D Trace Header Maps


F-T Frequency Slice Image



F-T Time Slice Image

Grid types generated in SeisViewer from SPW formatted seismic data include:



Eta Semblance
F-K Spectra



Gamma Semblance



HOVA (Horizon Velocity Analysis)



Instantaneous Amplitude



Instantaneous Frequency



Instantaneous Phase



Time Slices



Velocity (Velocity Field Displays)



Velocity Semblance



Velocity Semblance Delta-T

Grids are displayed in SeisViewer by selecting the Add Grid icon from the Add View Toolbar and scrolling out a subview drawing area.  Once the subview window has been created, a Grid Display dialog will appear that will require the user to provide information concerning the File format, the Display type, and the Input file name.  With the exception of Time Slice displays, each of the grids generated in SeisViewer from SPW formatted seismic data will require parameter input via the Options button located on the Grid Display dialog.

F-K Spectra
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 SeisViewer canvas displaying an F-K spectrum.

To create a SeisViewer canvas similar to the figure above, perform the following steps:

Step 1:
Open a Grid subview, set the Display type format to FK Spectrum and the File format to SPW Seismic.  Use the Source… button to select the SPW file that you wish to analyze in the FK domain. 
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Step 1: Select the File format, the Display type, and select the file for analysis.

Step 2:
Open the F-K Spectrum dialog by clicking on the Options… button in the Grid Display dialog.  The F-K Spectrum dialog is used to set parameters used to generate the F-K spectra.  Typically, the default parameters are sufficient to produce a meaningful F-K spectrum. Once the parameters have been specified, click on the OK button at the bottom of the dialog.
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Step 2: Set parameters in the F-K Spectrum dialog.

 Step 3:
Click OK in the upper left corner of the Grid Display dialog to generate the F-K spectra.
Step 4:
Annotate the spectrum.   Use a horizontal annotation subview to annotate the wavenumber axis.  Use a vertical annotation subview to annotate the frequency axis.   A color bar can be attached to display the amplitude scale of the spectrum.
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Step3:  Example of an F-K spectrum.

Fold Maps
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 SeisViewer canvas displaying an F-K spectrum.

To create a SeisViewer canvas similar to the figure above, a fold image must first be generated in FlowChart.  The fold image may be generated from an SPS dataset (i.e. theoretical fold), or from the seismic trace headers after the trace header geometry has been applied (i.e. actual fold).  To create a fold map from an SPS dataset, perform the following steps:

Step 1:
Build a flow in FlowChart by connecting source, receiver, and observer SPS files to a CMP Fold – Geometry (located in the Geometry/Binning… category) processing step.  Then link the CMP Fold – Geometry step to a CMP Fold Image step (located in the Image Data… category).
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Step 1: Build and run a processing flow to generate a fold image.

Step 2:
In SeisViewer, open a Grid subview, set the Display type format to Fold and the File format to SPW Grid.  Use the Source… button to select the CMP Fold image that you generated in FlowChart.
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Step 2: Open a grid subview, set the display type to Fold, and select the CMP Fold image that was generated in FlowChart.

 Step 3:
Click OK in the upper left corner of the Grid Display dialog to generate the Fold image.
Step 4:
Annotate the fold image.   Use a horizontal annotation to label crossline (i.e. CMP) number.  Use a vertical annotation to annotate the inline number.   A color bar can be attached to display the amplitude scale of the fold image.
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Step3:  Example of an F-K spectrum.

Velocity Semblance
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SeisViewer canvas displaying a velocity semblance gather.

To create a SeisViewer canvas similar to the figure above, perform the following steps:

Step 1:
Open a Grid subview, set the File format to SPW Seismic and the Display type format to Velocity Semblance.  Use the Source… button to select the file of uncorrected CMP gathers that will be used in the semblance analysis. 
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Step 1: Select File format, the Display type, and the CMP gathers for semblance analysis.

Step 2:
Open the Velocity Semblance dialog by clicking on the Options… button in the Grid Display dialog.  The Velocity Semblance dialog is used to set parameters for the semblance analysis.  Once the parameters have been specified, click on the OK button at the bottom of the Velocity Semblance dialog.
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Step 2: Set parameters in the Velocity Semblance dialog.

Step 3: 
Select Velocity Semblance from the pick file formats drop down menu in the Grid Display dialog, and select/create the file that will contain the time-velocity semblance picks defined by the interactive picking session.
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Step 3: Set the pick File format, and select/create velocity pick file.

Step 4:
Click OK in the upper left corner of the Grid Display dialog to generate the semblance gathers.

Step 5:
Pick the velocity semblance spectra to define a velocity function. To make a semblance pick, use the left mouse button and select points on the spectra where you would like the velocity function.  To edit a velocity pick, click on the pick with the left mouse button, hold down the button, and drag the velocity pick to the desired position.  To end the edit, double click with the left mouse button.  To delete a velocity pick, click once on the pick to select it, and then delete the pick with either the Delete Pick command located under the Edit menu, or simply hit Delete on the Keyboard.  To save the velocity file, select Save Canvas from the File menu.
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Step 5: Make velocity-time picks with the left mouse button.
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Step 5: To complete the function, double-click with the left mouse button.

Velocity Field Displays
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SeisViewer canvas displaying an interactively picked stacking velocity field.

To create a SeisViewer canvas similar to the figure above, perform the following steps:

Step 1: 
Perform stacking velocity analysis.  For marine data, this will probably involved semblance velocity analysis.  For land data, this will probably involve constant velocity stack analysis.   

Step 2:
Open a Grid subview. Set the Display type to Velocity and the Source file format to SPW Seismic.  Use the Source… button to select a seismic stacked section of the line on which you picked velocities.  The trace header values in this stacked section are used as a reference for the velocity field.  Adjust the horizontal and vertical scales as necessary.  Set the color scale under the Grid Style tab.  Add reference lines if desired.
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Step 2. Select the stacked section, set the File format to SPW Seismic, the Display type to Velocity.

Step 3:
Click on the Options… button to open the Velocity Model Options dialog.  Use the Browse button in the Velocity Model Options dialog to select the velocity file you wish to display.  To display the velocity field contained in a velocity file, check Display velocity pick locations. To display the interval velocity field corresponding to a selected stacking velocity field, check Apply Dix eqn for interval velocities.  Click OK in the Velocity Model Options dialog, followed by OK in the Grid Display dialog.
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Step 3.  The Velocity Model Options dialog.

Step 4:
Add vertical timing lines, horizontal locations, and a color bar.
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Step 4.  The velocity field display.

Templates
SeisViewer templates are read-only files that were designed to serve as examples of common SeisViewer canvases in which you view, analyses, and process data.  A text file accompanies each SeisViewer template that explains the purpose of the canvas, indicates how to use the canvas, and describes the inputs and outputs required by the canvas.  A zip file (Templates.zip) containing a complete range of SeisViewer and FlowChart templates is available as a free download from the Parallel Geoscience web site at:

ftp.parallelgeo.com/SPW_Products/Windows/Beta_Release/
The path name of each file in Templates.zip is specified relative to the pgc directory, which is C:\Program Files\pgc.  Therefore, you will want to extract the entire contents of the zip file to the C:\Program Files\pgc directory.   The next few pages will explain how to access and implement the template for viewing Field Files. 

Example Template: Field File QC

To access the Field File QC template, select Open Templates from the File menu.
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Step 1: select Open Template… from the File menu.

Selection of the Open Templates… will launch a dialog box that will prompt you to select a particular template.    
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The SeisViewer templates.

We are looking for the processing template that displays fully-annotated Field Files, so we will select the file Field File QC.tms, which is the SeisViewer template file (*tms) for the display of Field Files.    A SeisViewer canvas and its accompanying text file will open on the screen.
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The canvas Field File QC.tms and the accompanying text file.

SeisViewer templates, such as Field File QC.tms are read-only files that can be neither altered nor interacted with.  However, you may use the file by saving it as a new file and assigning the appropriate inputs and outputs.  In the case of Field File QC.tms, this would involve saving the file to a new directory (i.e. C:\My Project) and assigning the file a new name (i.e. Field File QC.can).  You would then associate a data file with the seismic bitmap by double-clicking on the seismic bitmap and using the Seismic… button to located under the File tab to assign the data set you wish to display.  Once the file has been renamed the seismic file has been re-assigned, the canvas is ready for viewing.
SeisViewer Processing
SeisViewer allows for the application and testing of a limited number of the processing steps currently available in the SPW Processing library.  Each of the processing steps in the SeisViewer processing library permits single channel operations.  A maximum of three of these processing steps may be applied sequentially to any input file.  Multichannel operations such as F-K filtering, Shot Deconvolution, and Migration are not available.

The processing steps currently available in the SeisViewer Processing library are:
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This chapter will illustrate SeisViewer’s processing capabilities through the interactive selection of deconvolution parameters.
Deconvolution parameter estimation
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The figure above illustrates an example of predictive-deconvolution parameter selection using the SeisViewer’s processing capabilities.  Trace-to-trace autocorrelations (top center) of the input gather (left) are used in the design of deconvolution operators.  Predictive deconvolution is applied to the input gather (right), and trace-to-trace autocorrelations of the deconvolved gather (bottom center) are used to qualify the deconvolution parameterization.  The remainder of the chapter will describe the procedures required to generate the above canvas.  If you have any questions regarding specific processing parameters, please consult the SPW Flow Chart manual.

To initiate any processing step or sequence of steps, we will always start with an input seismic data file. You may annotate the seismic display in any manner you like. 
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Input source record with relative-amplitude scaling.

The source record displayed in the figure above contains a few near-offset traces that contain high-amplitude noise bursts that should be edited prior to deconvolution or any subsequent processing steps.  Noisy traces can be edited interactively in SeisViewer through the use of the Kill Traces tool located under the Picking menu.  To activate the Kill Traces tool, select Kill Traces from the Picking drop down menu.

Selection of the interactive Kill Trace tool under the SeisViewer Picking menu.
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To kill a trace, simply position the cursor over the noisy trace and single click with the left mouse button.  The edited trace will be plotted as a straight line and the value <2> will be placed in the Trace Flag trace header field indicating that the trace is not to be processed.  The Unkill Traces tool is available to undo the action of the Kill Traces tool.  Again, simply select the Unkill Traces tool from the Picking menu, position the cursor over the previously killed trace, and click once with the left mouse button.  The Trace Flag header field will be restored to <0>, indicating that seismic trace is to be processed.  

The Picking menu also provides a Scale tool for interactively scaling individual traces, and an Invert Traces tool to interactively reverse the polarity of individual traces.

Illustration of trace kills with the interactive Kill Traces tool.

[image: image319.png]Page Hep

offset
TXLine 1
TXLoc 175,
2640 1430 220 1430 2640

I i
e
e
ll;% ) i”’z”ﬁ

‘

Input Gather

0K Apply Restore | { Cancel |

Fie | Homais || Vertaus || Seaing || Piotsvie ][ Anmaion || Process

Seismic... | CiDataKansasiSPW Data) Tx175.5pw
File fomat [P Format ~| Find.. | Ccustomize..

Picks... | CiDatalKansas\SPW Datal decon guide function

Fieformat  [Early Mute -] options... | Help...

Sortkeys
ey Namelunits Header fieldindex
Primay  [TX Line [Source Line

Secondary  [TX Loc [Source Location

Lellef o]

Terian [offset [Source-Receiver Offset

Time 208333 Offset 1210.0





Subsequent processing of the selected shot gather will not take into account the edited traces. The gather is now ready for parameter testing.

The spatial and temporal position of deconvolution design windows within SPW may be controlled by one of two means: as a linear function of offset (i.e. LMO), or as a function of an Early Mute card.  In the present example, we will illustrate the use of an Early Mute card to control the position of the design window.  

Double click on the seismic bitmap to open the Seismic Display dialog.  Set the pick file format to Early Mute and use the Picks… button to select/create the card data file that will contain the early mute functions defined by the interactive picking session.  To pick the early mute on the input gather, use the left mouse button and select points on the gather where you would like the mute function.  To edit a mute pick, click on the pick with the left mouse button, hold down the button, and drag the mute pick to the desired position.  To end the edit, double click with the left mouse button.  To delete a mute pick, click once on the pick to select it, and then delete the pick with either the Delete Pick command located under the Edit menu, or simply hit Delete on the Keyboard. To view the mute function, select Spreadsheet from the Windows menu on the main toolbar.  To save the mute file, select Save Canvas from the File menu.
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Set the pick file format to Early Mute, and select the file that will contain the early mute function.
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Pick the Early Mute function that will control the start time of the deconvolution design window.

The first step in the design of prediction deconvolution parameters is the generation of trace-to-trace autocorrelations.  Autocorrelations are used to design the prediction gap and the deconvolution operator length.  Create a second Seismic Bitmap subview and select the same seismic file that is displayed in the subview titled “Input Gather”.  To set the processing parameters that will be applied to the second Seismic Bitmap subview, click on the Process tab.
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Select the input gather from which to generate trace-to-trace autocorrelations.
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The Process menu

The autocorrelations will be generated from data samples that follow a time function defined in the Early Mute card.  Therefore, the first processing step will be to apply this mute function.  Select the Apply Early Mute step from the drop down menu in the Process 1 submenu.  Once the Apply Early Mute step has been selected, use the File… button to the right of the drop down menu to select the early mute file picked on the input gather.  Use the Parameters… button to the immediate right of the drop down to select the mute taper length and the mute taper type.
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First processing step: Apply Early Mute
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The Early Mute Card File selection dialog
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The Apply Early Mute parameter dialog

The second process is the computation of the trace autocorrelations.  Select the Autocorrelation step from the drop down menu in the Process 2 submenu.  Once the Autocorrelation step has been selected, the Parameters… button to the immediate right of the drop down menu will become activated requesting user supplied parameters.  In this case, a zero lag time of 0ms will be sufficient.  After the Autocorrelation parameter dialog has been completed, click on Apply towards the upper left corner of the Seismic Display dialog.
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Second processing step: Autocorrelation
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The Autocorrelation parameter dialog.

Application of an early mute and single-channel autocorrelation to the input gather.
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At this point we chose to scale down the autocorrelations through the application of a whole-trace, single-channel AGC to each of the autocorrelations in order to make them interpretable.  The trace length of each of the autocorrelations, which is listed under the Vert Axis tab, is 1196ms.  Therefore, a single-channel AGC with an AGC window length of 1196ms will be applied.  Once the parameterization is correct, click on Apply at the top of the Seismic Display dialog.  Since the autocorrelations will be used in the selection of deconvolution parameters, you may wish to annotate the display both vertically and horizontally.
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Final display of single-channel autocorrrelations.
The autocorrelations displayed in the second subview are used to estimate the prediction gap and the deconvolution operator length.  For the purpose of this example, the prediction gap and the operator length will be set to 24ms and 100ms, respectively, based on analysis of the autocorrelations.  To apply predictive deconvolution to the input gather, create a third Seismic Bitmap subview and select the same seismic file that is displayed in the previous subviews.  To set the processing parameters that will be applied to the third Seismic Bitmap subview, click on the Process tab.  First, select the Spherical Divergence Correction step from the drop down menu in the Process 1 submenu.  Once the Spherical Divergence step has been selected, the Parameters… button to the immediate right of the drop-down menu will become activated requesting user supplied parameters.  In this case, the default parameters are sufficient. The second process is predictive deconvolution.  Select the Deconvolution step from the drop down menu in the Process 2 submenu.  Once the Deconvolution step has been selected, the Parameters… button to the immediate right of the drop-down menu will become activated requesting user supplied parameters.  In this case, we will apply a predictive deconvolution with a gap length of 24ms, an operator length of 100ms, a design window start time that is defined in an Early Mute card, and a design window length of 800ms.  Use the File… button to select the Early Mute function that was previously designed on the input gather.  After the Deconvolution parameter dialog has been completed, click on OK towards the upper left corner of the Seismic Display dialog.

[image: image331.png]Deconvolution

Deconvoll
Type Of Operator Pre-whitening 09 [0.100
 Spiking Inverse filter length (ms) [100.0
© Predicive e e ———
(e stiom (emogth (o) |l Overlap of design window (ms) [500.0
I Use horizon input for prediction Design window start fms) {0.0
o Design window length (ms) [800.0

I™ Apply moveout to decon design window

H
LW

Cancel




Select the input gather on which to apply deconvolution.

First step: Apply spherical divergence correction to the input gather.
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The Spherical Divergence parameter dialog.

Second step: Apply predictive deconvolution to the input gather.
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The Deconvolution parameter dialog.


The Early Mute Card File selection dialog.

Finally, fully annotate the deconvolved gather.


The application of a spherical divergence correction and single-channel predictive deconvolution.

To qualify our choice of prediction deconvolution parameters, we will generate a final set of trace-to-trace autocorrelations that are meant to illustrate both the dereverberation of the individual seismograms and the contraction of the seismic wavelet.  To produce this display, create a fourth Seismic Bitmap subview and select the same seismic file that is displayed in the previous subviews.  To set the processing parameters that will be applied to the fourth Seismic Bitmap subview, click on the Process tab.  The processing sequence will consist of a spherical divergence correction, predictive deconvolution using the previously applied parameters, and single channel autocorrelations.  

Final processing steps: Apply a spherical divergence correction, a predicitive deconvolution, and compute autocorrelations.
After each of the relevant parameter dialogs have been completed, click on OK towards the upper left corner of the Seismic Display dialog.  The final canvas should look something like the following:

Final Deconvolution canvas.


Try different operator length, gap lengths, and design windows to see what effect they have on the resulting output correlations, and always remember to save your work.

SeisViewer Applications

This chapter describes specific applications that are ideally performed in SeisViewer.  The applications include:

F-K Filter Design

Mute Picking


- Early Mutes


- Tail Mutes

First Break Picking
Linear Velocity Analysis

Time Picking


- Horizon Time Picking

Stacking Velocity Analysis


- Semblance Velocity Analysis

- Constant Velocity Analysis
F-K Filter Design


SeisViewer canvas displaying an input gather with noise (left), it’s F-K spectra (top center), the F-K filtered input gather (right), and the F-K spectra of the filtered input gather (bottom center). 

To create a SeisViewer canvas similar to the figure above, perform the following steps:

Step 1: 
In FlowChart, create a flow similar to the example below.  At a minimum, the flow should contain an input data set, an Apply F-K Filter step to apply the F-K filter, and an output data set.

Example flow to apply the F-K filter.
Step 2: 
In SeisViewer, open a Seismic Bitmap subview, and select the seismic data file that contains the input gathers with noise.  Set the horizontal, vertical, and scaling parameters as desired.  Annotate with trace header attributes if desired.  
Step 2: Open the seismic file that contains the input gathers with noise.
Step 3:
Open a Seismic Grid subview, set the seismic file format to SPW Seismic, the Display type to FK Spectrum, and use the Seismic… button to select the SPW file that contains the input gathers with noise.  Optional FK spectra parameters can be set by clicking on the Options… button located under the Grid tab.  Set the horizontal, vertical, and scaling parameters as desired.  

Step 4:
F-K filters are implemented as surgical mutes in the F-K domain.  Therefore, set the pick file format to FK Mutes, and use the Pick… button to select/create the surgical mute file that will contain the FK filter defined by the interactive design session.

Step 5: 
Click OK.


Steps 3-4: Set the seismic file format to SPW Seismic, set the Display type to FK Spectrum, select a SPW seismic file to analyze in the FK domain, set the pick file format to FK Mutes, and select/create the surgical mute file that will contain the FK filter.

Step 6:
Annotate with vertical (Frequency) and horizontal (Wavenumber) axes.

Step 6: An annotated F-K spectra generated from the input gather with noise.
Step 7: 
Pick the F-K spectra to define the F-K filter. To make a filter pick, use the left mouse button and select points on the spectra where you would like the filter function.  To edit a filter pick, click on the pick with the left mouse button, hold down the button, and drag the filter pick to the desired position.  To end the edit, double click with the left mouse button.  To delete a filter pick, click once on the pick to select it, and then delete the pick with either the Delete Pick command located under the Edit menu, or simply hit Delete on the Keyboard. To advance to additional gathers, use the arrow keys.  To save the F-K filter function file, select Save Canvas from the File menu.

Step 7a: Pick the first point of the F-K filter.      Step 7b: Pick the second point of the F-K filter.

Step 7c: Pick the third point of the F-K filter.  Step 7d: Pick the fourth point of the F-K filter.

Step 7e: Pick the fifth point of the F-K filter.

Step 7f: Double-click the first point to end.

Step 8:
The resulting FK Mute file can be viewed, and if necessary, refined, by opening the card data spreadsheet from the Window tab on the main menu. 


Step 8a: The FK mute file resulting from the interactive picking session.


Step 8b: An edited FK mute file.

Step 9:
In FlowChart, apply the F-K filter in Step 8 to the input data (using the processing flow outlined in step 1).

Step 10:
In SeisViewer, open a second Seismic Bitmap subview, and select the seismic data file that contains the F-K filtered input gather.  Set the horizontal, vertical, and scaling parameters as desired.  Annotate with trace header attributes if desired.


Step 10: Open the seismic file that contains the F-K filtered input gathers. 

Step 11:
To further qualify the effects of the F-K filter on the input gather, generate an F-K spectrum of the F-K filtered gather.  Open a second Seismic Grid subview, and select the SPW file that contains the F-K spectra of the filtered input gathers.  Set the horizontal, vertical, and scaling parameters as desired.  Annotate with trace header attributes if desired.


Step 11: A display of the input gather with noise (left), it’s F-K spectra (top center), the F-K filtered input gather (right), and the F-K spectra of the filtered input gather (bottom center).

Mute Picking

SeisViewer is designed for the interactive picking of early, surgical, and tail mutes.  Each of these picking applications makes use of an intuitive point-and-click interface.  To make a mute pick, use the left mouse button to select points on the gather where you would like the mute function.  To edit a mute pick, click on the pick with the left mouse button, hold down the button, and drag the mute pick to the desired position.  To end the edit, double click with the left mouse button.  To delete a mute pick, click once on the pick to select it, and then delete the pick with either the Delete Point command located under the Edit menu, or simply hit Delete on the Keyboard.  The arrow keys are used to step through the data according to the sort keys that have been set under the File tab of the Seismic Display dialog.

Interactive mute picking of pre-stack gathers (Common Source, Common Receiver, Common CMP, etc…) requires that the Primary and Secondary sort keys be set according to Line and Location of the gather to be picked.  For example, if mute picking is to be performed on CMP gathers, then the Primary sort key must be set to CMP Line and the Secondary sort key must be set to CMP Location.  The Tertiary sort key will be set to an appropriate value.  In the case of CMP gathers, this could be Source-Receiver Offset.  Interactive picking of post-stack mutes will generally be performed on stack sections displayed with the Primary sort key set to CMP Line and the Tertiary sort key set to CMP Location.  The Secondary sort key will default to None.

As with all other SeisViewer applications, mute picking may be performed on either SPW or SEGY data sets.  To begin a picking session, open a Seismic Bitmap subview, set the seismic file format (SPW or SEGY) in the Seismic Display dialog, and select the seismic data file using the Seismic… button.  In a similar fashion, set the pick file format (Early, Tail, or Surgical Mute) from the appropriate drop down menu, and then select/create the pick file using the Picks… button.  This is the card data file that will contain the mute functions defined by the interactive picking session.

A Pick options dialog located under the Picking menu gives the user a choice of whether or not to display the muted area as a shaded region.  The Pick options dialog also controls the spatial interpolation of the mute function between pick locations.

The remainder of the chapter will provide a step-by-step illustration of the interactive picking and application of Early, Tail, and Surgical mutes on normal moveout corrected CMP gathers.  Keep in mind that each of the mute picking demonstrations is only an example and that SeisViewer mute picking tools may be customized to your particular data needs.

Early Mute picking


SeisViewer canvas demonstrating the interactive picking and application of an early mute.

To create a SeisViewer canvas similar to the figure above, perform the following steps:

Step 1: 
Open three Seismic Bitmap subviews, each of which will point to the same seismic data file.  In this case, that seismic data file will consists of one or a series of CMP gathers.  Set the horizontal, vertical, and scaling parameters as desired.

Step 2:
Use the Layer Table to synchronize each of the gathers both vertically and horizontally (see page EDIT for a description of the Horizontal scroll group).

Step 3:
The first subview will contain a display the uncorrected CMP gather.  Therefore, no further processing need be performed on this gather.  

Step 4:
In the second subview, double-click on the seismic data to bring forth the Seismic Display dialog.  Select Early Mute from the pick file formats drop down menu, and name the pick file using the Pick… button.  This will be the card data file that contains the early mute functions defined by the interactive picking session.

Step 4.  Select the seismic data, the mute file, and the mute type.


Step 5:
In the Process menu of the Seismic Display dialog corresponding to the second seismic bitmap, apply a normal moveout correction using a rough or previously existing velocity file.  Select this file with the File… button in the Process 1 submenu.  Turn off the stretch mute option in the Parameter… dialog, this will allow the design of an NMO mute function on fully NMO corrected CMP gathers.  Once the file and the parameters have been set, click on the OK button in the upper left corner of the Seismic Display dialog.
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Step 5.  Application of a normal moveout correction under the Process menu.

Step 6:
Pick the early mute on the moveout corrected gather. To make a mute pick, use the left mouse button and select points on the gather where you would like the mute function.  To edit a mute pick, click on the pick with the left mouse button, hold down the button, and drag the mute pick to the desired position.  To end the edit, double click with the left mouse button.  To delete a mute pick, click once on the pick to select it, and then delete the pick with either the Delete Pick command located under the Edit menu, or simply hit Delete on the Keyboard. To advance to the next gather, use the arrow keys.  To save the mute file, select Save Canvas from the File menu.

Step 7:
Choose Save Canvas from the File menu to save the early mute file.  Saving the mute file is necessary for subsequent application in the third seismic subview.

Example of an Early Mute card file.

Step 8:
In the third subview, double-click on the seismic data to bring forth the Seismic Display dialog.  In the Process menu of the Seismic Display dialog set the Process 1 process type to Apply Normal Moveout, and select the same velocity function used in the second subview.  Be sure to turn off the stretch mute option.  In the Process 2 submenu, set the process type to Apply Early mute, and select the early mute file created in the second subview with the File… button.  The Parameter… dialog can be used to set the taper type and control the taper length of the mute zone.  Once the file and the parameters have been set, click on the OK button in the upper left corner of the Seismic Display dialog.  The muted gather will appear in the third subview.

Step 8. Application of the early mute under the Process menu.

Step 9:
To apply the interactively picked mutes in a FlowChart, select Apply Early Mute from Mutes… in the processing list, and link an Early Mute card as shown in the example below.

Example flowchart showing the application of an early mute.

Tail Mute picking


SeisViewer canvas demonstrating the interactive picking and application of a tail mute.

To create a SeisViewer canvas similar to the figure above, perform the following steps:

Step 1: 
Open three Seismic Bitmap subviews, each of which will point to the same seismic data file.  In this case, that seismic data file will consists of one or a series of CMP gathers.  Set the horizontal, vertical, and scaling parameters as desired.

Step 2:
Use the Layer Table to synchronize each of the gathers both vertically and horizontally.

Step 3:
The first subview will contain a display the uncorrected CMP gather.  Therefore, no further processing need be performed on this gather.  

Step 4:
In the second subview, double-click on the seismic data to bring forth the Seismic Display dialog.  Select Tail Mute from the pick file formats drop down menu, and name the pick file using the Pick… button.  This will be the card data file that contains the tail mute functions defined by the interactive picking session.  

Step 4. Select the seismic data, the mute file, and the mute type.
Step 5:
In the Process menu of the Seismic Display dialog corresponding to the second seismic bitmap, apply a normal moveout correction using a rough or previously existing velocity file.  Select this file with the File… button in the Process 1 submenu.  Turn off the stretch mute option in the Parameter… dialog, this will allow the design of the tail mute function on fully NMO corrected CMP gathers.  Once the file and the parameters have been set, click on the OK button in the upper left corner of the Seismic Display dialog.
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Step 5. Application of a normal moveout correction under the Process menu.

Step 6:
Pick the tail mute on the moveout corrected gather. To make a mute pick, use the left mouse button and select points on the gather where you would like the mute function.  To edit a mute pick, click on the pick with the left mouse button, hold down the button, and drag the mute pick to the desired position.  To end the edit, double click with the left mouse button.  To delete a mute pick, click once on the pick to select it, and then delete the pick with either the Delete Pick command located under the Edit menu, or simply hit Delete on the Keyboard. To advance to the next gather, use the arrow keys.  To save the mute file, select Save Canvas from the File menu.

Step 7:
Choose Save Canvas from the File menu to save the tail mute file.  Saving the mute file is necessary for subsequent application in the third seismic subview.

Example of a Tail Mute card file.
Step 8:
In the third subview, double-click on the seismic data to bring forth the Seismic Display dialog.  In the Process menu of the Seismic Display dialog set the Process 1 process type to Apply Normal Moveout, and select the same velocity function used in the second subview.  Be sure to turn off the stretch mute option.  In the Process 2 submenu, set the process type to Apply Tail mute, and select the tail mute file created in the second subview with the File… button.  The Parameter… dialog can be used to set the taper type and control the taper length of the mute zone.  Once the file and the parameters have been set, click on the OK button in the upper left corner of the Seismic Display dialog.

Step 8. Application of the tail mute under the Process menu.


Step 9:
To apply the interactively picked mutes in a FlowChart, select Apply Tail Mute from Mutes… in the processing list, and link a Tail Mute card as shown in the example below.


Example flowchart showing the application of a tail mute.
First-Break Picking
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SeisViewer canvas demonstrating the interactive picking of first-arrival times.

To create a SeisViewer canvas similar to the figure above, perform the following steps:

Step 1: 
Open a Seismic Bitmap subviews, and select a seismic data file with geometry updated trace headers.  After the seismic file has been selected, set the Pick File format to First Break Times, and click on the Picks… button to assign an output file name for the first-break picks.

Step 2:
In the second subview, double-click on the seismic data to bring forth the Seismic Display dialog.  Select Early Mute from the pick file formats drop down menu, and name the pick file using the Pick… button.  This will be the card data file that contains the early mute functions defined by the interactive picking session.
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Step 4. Select the seismic data, set the pick file format, and assign pick file name.
Step 3:
Once the pick file name has been assigned, picking can begin.  However, you may first want to inspect the options for first break picking.  These options are located under Picking->Pick Options… on the main menu.
[image: image112.png]2 SeisViewer

<

Edt_Addview Step View |Pickng | Drawng Windon e

s 12 8 2 2 m @
v L o Do T b T

e 72 15 s 8 @ w %
v e b e T

g ] g H H H H

H

g
I

g

H

H

H

g

g

H

g

H

Time 9722 Channel 5.0 Amplitude -0.00014013

g





Accessing the Pick Options menu
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The Time Pick Options menu
Step 4:
Pick the first breaks.  
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      Step 4a.  Pick a point by clicking the mouse button                   Step 4b.  Click a second point.

[image: image116.png]



Step 4c.  Release the mouse button to pick the segment between the first and second point.

Step 5:
Complete the picking.

Linear Event Picking

SeisViewer canvas demonstrating the interactive picking of refractor velocities from first-break times.

To create a SeisViewer canvas similar to the figure above, perform the following steps:

Step 1: 
Open a Seismic Bitmap subview.  Set the File format to SPW Seismic and use the Source… button to select a seismic data file appropriate for picking refractor velocities from first break arrival times. 

Step 1.  Select the seismic File format and the input file name.


Step 2: 
Select Refraction Velocity from the pick file formats drop down menu in the Seismic Display dialog, and select/create the file that will contain the layer-location-velocity picks defined by the interactive picking session.


Step 2.  Select the pick File format and the pick file name.

Step 3:
When you select an SPW file for refractor velocity picking the sort keys must be set to one of three configurations: 

Common Source configuration

Primary

-
Source Line 

Secondary
-
Source Location

Tertiary

-
Source-Receiver Offset

Common Receiver configuration

Primary

-
Receiver Line 

Secondary
-
Receiver Location

Tertiary

-
Source-Receiver Offset

Common Midpoint configuration

Primary

-
CMP Line 

Secondary
-
CMP Location

Tertiary

-
Source-Receiver Offset

In this example, we will work with the Common Source configuration.  Set the display parameters as desired. Set the horizontal, vertical, and scaling parameters as desired 

Step 4:
Click OK in the upper left corner of the Seismic Display dialog to and the seismic bitmap display will appear.  Annotate with vertical, horizontal, and trace header attributes as desired.

Step 5:
Use the Layer Table to synchronize each of seismic gathers with the vertical and horizontal annotations.

Step 6: 
Pick the refractor velocity corresponding to the first layer. To make a velocity pick, use the left mouse button and select a first-arrival time corresponding to the near-offset portion of the refractor. To complete a velocity pick, use the left mouse button and select a first-arrival time corresponding to the far-offset portion of the refractor.  To edit a velocity pick, click on the pick with the left mouse button, hold down the button, and drag the velocity pick to the desired position.  To end the edit, double click with the left mouse button.  To delete a velocity pick, click once on the pick to select it, and then delete the pick with either the Delete Pick command located under the Edit menu, or simply hit Delete on the Keyboard.  To save the velocity file, select Save Canvas from the File menu.


Step 6.  Select the first point on the refractor.


Step 6.  Select the second point on the refractor.  The velocity of this layer will appear in the lower-left corner of the SeisViewer canvas.
Step 7: 
Pick refractor velocities corresponding to additional layers.  Additional refractor velocity picks are made by selecting additional pairs of first-arrival times, and the values of each layer will be written to the Card data file with a sequentially updated layer number.


Step 7.  Refractor velocity pick for layer two.


Step 7.  Refractor velocity pick for layer three.

Step 8:
Continue picking refractor velocities until the all layers have been picked.  Use the arrow keys to step forward to the next gather you wish to pick.  

Step 9: 
Save the refractor velocity card data file by saving the canvas.

Example of a Refractor Velocity card file.
Time Picking

SeisViewer is designed for the interactive picking of first break times and event times.  Each of these picking applications makes use of an intuitive point-and-click interface. 

A Pick Options dialog located under the Picking menu allows seismic arrivals to be picked on either a trace-to-trace basis or on a linear-guided basis.  The same dialog provides options for automatic picking of seismic arrivals on the peak, on the trough, on the zero crossing, or without regard to a sample attribute.  Finally, in the case of first break time picking, the time picks from the previous or the next gather may be displayed as a reference for picking first breaks on the current gather.

To make a time pick, use the left mouse button to select points on the display where you would like the pick.  If you are using the linear-guided picking option, use the mouse button to select the first and last points to be picked.  If the mouse button is held down on the last point, a visual rubber band will stretch between the two points that indicates where the algorithm will search for seismic arrivals.  All the traces between the two points will be picked automatically based on the Pick Type criteria selected in the Pick Options dialog.  To edit a single time pick, click on the pick with the left mouse button, hold down the button, and drag the time pick to the desired position.  If signal-to-noise considerations prevent the picker from placing the time pick according to the Pick Type criteria, you will want to change the Pick Type to “No event detection”.  The “No event detection” criteria will allow you to place the pick wherever you click the left mouse button.  To end the time picking of a given layer, double click with the left mouse button.  This will cause subsequent picks to be identified with another layer.  To delete a time pick, click once on the pick to select it, and then delete the pick with either the Delete Point command located under the Edit menu, or simply hit Delete on the Keyboard.  The arrow keys are used to step through the data according to the sort keys that have been set under the File tab of the Seismic Display dialog.

As with all other SeisViewer applications, time picking may be performed on either SPW or SEGY data sets.  To begin a picking session, open a Seismic Bitmap subview, set the seismic file format (SPW or SEGY) in the Seismic Display dialog, and select the seismic data file using the Seismic… button.  In a similar fashion, set the pick file format (First Break Times or Event Time Picks) from the appropriate drop down menu, and then select/create the pick file using the Picks… button.  This is the card data file that will contain the time picks defined by the interactive picking session.

The remainder of the chapter will provide a step-by-step illustration of the interactive picking of first break times on a shot gather and event times on a stacked seismic section. Keep in mind that each of the time picking demonstrations is only an example and that SeisViewer time picking tools may be customized to your particular data needs.

Horizon Time Picking

SeisViewer canvas demonstrating the interactive picking of seismic horizons on a stacked section.

To create a SeisViewer canvas similar to the figure above, perform the following steps:

Step 1: 
Open a Seismic Bitmap subview, and select a seismic data file appropriate for picking event times.  Set the horizontal, vertical, and scaling parameters as desired.  Annotate with a trace header plot if desired.  

Step 2:
If needed, use the Layer Table to synchronize each of seismic gathers with the vertical and horizontal annotations.

Step 3:
Double-click on the seismic data display to bring forth the Seismic Display dialog.  Select Event Time Picks from the pick file formats drop down menu, and select/create the pick file using the Pick… button.  This will be the card data file that contains the first break time picks defined by the interactive picking session.

Step 4:
Open the Pick Options… dialog under the Picking menu.  Set the Pick Method to Linear guided picking.  Set the Pick Type to Detect peak (or as appropriate).

Step 5:
Select an event on one of the stacked traces with the left mouse button. 

Step 5.  Selection of the event time on the first trace of the stacked section.

Step 6:
Select the same event on another one of the stacked traces with the left mouse button.  Hold down the cursor to make the interconnecting rubber band visible.


Step 6.  Select the second event time and hold down cursor.  The rubber band will appear between picks.
Step 7:
Release the mouse button to automatically pick each event time between the two selected traces.

Step 7.  Each event between the two pick traces is automatically picked upon release of the mouse button.
Step 8:
Pick all event times from the first trace to the last trace.  Double click on the last trace to complete the picking of the layer.  After double clicking, the event picks will change color and you are ready to pick the next event.

Step 8.  Double click on the last trace to complete picking the layer.  The event picks will change color and you may begin picking the next horizon.

Step 9:
Pick the remaining events.


Step 9.  Proceed with picking additional horizons.

Step 10: 
Save the time picks by saving the canvas.

Example of a Horizon File.

Stacking Velocity Analysis

SeisViewer provides a very flexible environment for the interactive analysis of stacking velocities by means of eta semblance spectra, gamma semblance spectra, velocity semblance spectra, constant velocity stacks, hyperbolic moveout picking, delta-t stacks, and horizon velocity analysis.  Each of these picking applications makes use of an intuitive point-and-click interface.  To make a velocity pick, use the left mouse button to select points on the seismic bitmap where you would like the velocity function.  To edit a velocity pick, click on the pick with the left mouse button, hold down the button, and drag the velocity pick to the desired position.  To end the edit, double click with the left mouse button.  To delete a velocity pick, click once on the pick to select it, and then delete the pick with either the Delete Point command located under the Edit menu, or simply hit Delete on the Keyboard.  The arrow keys are used to step through the data according to the sort keys that have been set under the File tab of the Seismic Display dialog.

The remainder of the chapter will provide a step-by-step illustration of the interactive picking and application of stacking velocity functions by means reflection hyperbola, the various semblance spectra, constant velocity stacks, delta-T stacks, and horizon velocity analysis.  Keep in mind that each of these demonstrations is only an example and that SeisViewer velocity analysis tools may be customized to your particular data needs.

Semblance Velocity Analysis
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SeisViewer canvas for velocity analysis through the interactive picking of semblance spectra (left) generated from CMP gathers (center) and the resulting velocity field (right).

There are two methods available for creating and picking semblance gathers such as the one displayed on the left in the figure above.  In the first method, semblance gathers are generated from CMP gathers in Flowchart and output as an SPW formatted seismic file.  These semblance gathers are then loaded into SeisViewer as a Seismic Bitmap display.  In the second method, semblance gathers are generated in SeisViewer directly from CMP gathers that are loaded into a SeisViewer Grid display.  In each case the parameterization that controls the generation of semblance gathers is identical.  Method #1 will be described first followed by method #2.

[image: image118.png]Grid Display

Grid. Grid Style

F1SEG2007Ross Sea GMP Gathers o Velan 1 spw
rietama

Displaytipe  Velocity Semblance [ options:
FASEG2007Ross Seal Velan 1.pics

Fileformat  Velocity Semblance [_options... |
Grd Scal

Horzontal sale | 500 Velfin Vercal scale | 2.75 infsec
Horizontal size [a1in Verticalsize [11.2585 in

Startloc [o11.5 Step size [0s





Step 1:
Open a Seismic Grid subview, set the File format to SPW Seismic and the Display type format to Velocity Semblance.  Use the Source… button to select the file of uncorrected CMP gathers that will be used in the semblance analysis.  Set the pick file format to Velocity Semblance and create/select the velocity file that will contain the time-velocity picks defined by the interactive picking session.

Step 1: Select file format, the display type, and the CMP gathers for semblance analysis.

Step 2:
Open the Velocity Semblance dialog by clicking on the Options… button in the Grid Display dialog.  The Velocity Semblance dialog is used to set parameters for the semblance analysis.  Once the parameters have been specified, click on the OK button at the bottom of the Velocity Semblance dialog, followed by the OK button in the upper-left corner of the Grid Display dialog.  The velocity semblance gather will be generated.
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Step 2: Set parameters in the Velocity Semblance dialog.

Step 3:
Open a second Seismic Bitmap subview, and select the SPW formatted file of uncorrected CMP gathers that was input to the Velocity Semblance step in Step 1.  Set the horizontal, vertical and scaling parameters as desired.  Annotate with the appropriate horizontal, vertical and trace header attributes.
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Step 3.  Select the CMP gather seismic file used to generate the semblance spectra.

Step 4:
In the Process menu of the Seismic Display dialog corresponding to the seismic bitmap that contains the CMP gathers apply a normal moveout correction using the velocity file being currently being picked on the adjacent semblance gather.  Select this file with the File… button in the Process 1 submenu.  Use the Parameter… dialog to set the stretch mute to a desired value. Once the file and the parameters have been specified, click on the OK button in the upper left corner of the Seismic Display dialog.  Optionally, you may apply a pre-picked NMO stretch mute.
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Step 4.  Apply a normal moveout correction to the CMP gathers with velocity currently being picked on the adjacent semblance spectra.
Step 5:
Link the horizontal scroll groups between the semblance display and the CMP gather display.  Once linked, a pick on the semblance spectra may be qualified by viewing the moveout on the corresponding CMP gather.

Step 6:
Select Pick Traces from the Picking menu.

Step 7:
Open the Pick Options… dialog under the Picking menu.  If checked, velocity functions from either the previous or the next semblance gather may be displayed as a reference for picking a velocity function on the current semblance gather.


Velocity Pick Options dialog

Step 8:
Pick the velocity semblance spectra to define a velocity function. To make a semblance pick, use the left mouse button and select points on the spectra where you would like the velocity function.  To edit a velocity pick, click on the pick with the left mouse button, hold down the button, and drag the velocity pick to the desired position.  To end the edit, double click with the left mouse button.  To delete a velocity pick, click once on the pick to select it, and then delete the pick with either the Delete Pick command located under the Edit menu, or simply hit Delete on the Keyboard.  To save the velocity file, select Save Canvas from the File menu.
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Step 8.  Select time-velocity pairs on the spectra with the mouse button.
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Step 8 (cont).  Complete the selection time-velocity pairs by double-clicking with the mouse button.

Step 9:
Select velocity functions for each semblance spectra in the data file.

Step 10:
Choose Save Canvas from the File menu to save the velocity file.

Step 11:
Open a Seismic Grid subview.  Set the Source file format to SPW Seismic and select a previously generated stacked seismic section using the Source… button.  The trace header values in this stacked section are used as a reference for the velocity field.  Set the Source Display type to Velocity.  
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Step 12.  Select a reference stacked section and set the Display type to Velocity.

Step 12:
Click on the Options… button to select a velocity file.  Use the Browse button in the Velocity Model Options dialog to select the Semblance velocity file created in Steps 1-8.  To display the stacking velocity field, check Display velocity pick locations.
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Step 13.  The Velocity Model Options dialog.

Step 13:
Once the Semblance velocity file and the display options have been specified, click OK in the Velocity Model Options dialog, followed by OK in the upper left corner of the Grid Display.  The stacking velocity field determined through interactive analysis of semblance spectra will be displayed in the Seismic Grid subview.  Annotate horizontally and vertically as desired.
[image: image126.png]2 SeisViewer
2L SeisViewer Canvas
| Il | L Il |1 IR e s s e
E 5 7
< 5
Time79.545 Offset 3250 Amplitude -0.62649 &





Step 13.  Display of the stacking velocity field picked through interactive analysis of the semblance spectra. 

The velocity functions determined through interactive picking of semblance gathers are applied by linking a Velocity card data file to the Apply Normal Moveout step as shown in the example flowchart.


Application of semblance gather velocity picks.

Constant Velocity Analysis
SPW Vector Calculator

The SPW Vector Calculator is designed for use with the SPW SeisViewer.  It is an interactive analysis and display tool, possessing operators such as Fast Forward (and Inverse) Fourier Transform and Auto-Correlation, as well as a number of data display options for graphing your results. 
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Vector Calculator

The Vector Calculator allows you to operate on scalar numbers, vectors, or a matrix of data. This means you can analyze and process selected seismic traces, as well as a window of your seismic data. You can even program your own keys to preserve your favorite functions. 

Memory

The Memory portion of the Vector Calculator holds the data being transferred from the SeisViewer.  You will find it located in the lower left corner of the Vector Calculator Keypad display.

[image: image128.png]414 Vector Calculator

Fie Edt

Stack ©DEG_O RAD O GRAD ] cyrrent Confi

ration

2} | Default Configuration

E-m
Hanning Polar

Tan Cmplx RPart

[#1] [crpSun] (Groave

Reclp AmpSpc SNoise

Conv TextDump





Vector Calculator Memory
Stack

The Stack portion of the Vector Calculator holds the data transferred from the Vector Calculator's Memory.  You will find it located in the upper left corner of the Vector Calculator Keypad display.
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Vector Calculator Stack
Data Entry

Selecting Data from SeisViewer

First open both the SeisViewer and the Vector Calculator modules.  Bringing data into the SPW Vector Calculator begins in the SeisViewer module.  After calling data into the SeisViewer, go to the Picking menu and choose Select Traces.  


Selecting Traces from SeisViewer

Then click on the trace(s) you want to transfer to the Vector Calculator.  The selected traces will automatically be placed into computer memory.  

Transfering Data to Vector Calculator

Switch to the Vector Calculator and choose Paste from the Edit menu in the Vector Calculator module.  The traces will be added to the calculator's Memory.  
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Pasting Data in Vector Calculator

The Memory portion of the display window will contain the trace numbers, identifying them as coming from the SeisViewer clipboard.
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Data in Vector Calculator

Moving Data from Memory to Stack

Once you have pasted data from SeisViewer into Vector Calculator's Memory, move the data to the Stack by clicking on it.  The traces will be added to the calculator's Stack.  
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Moving Data from Memory to Stack

The Stack portion of the display window will now contain the same information as the Memory.  Operations may now be performed on the data by using the function keys.

Performing Operations 

Once the data has been moved to the Stack, you may perform operations on it by using the function keys.  
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Using the Function Keys to Perform Operations

By selecting a function key, such as AutoCorrelation (Acorr), the operation is performed as indicated in the Stack, which now carries the function key's name.

Display the Results

After using the function keys to perform operations on your data you are ready to display the results.  
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Using the Plot Key to Display Results

By selecting the Plot key, the results of the operations you performed on your data are displayed in the Vector Calculator plot window.

Adjusting the Display

Finally, you may adjust the display of the results of the operations you performed on your data by double-clicking on the display.  
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Using the Plot Scale Settings to Adjust the Display

This will open a Plot Scale Settings dialog box in which you can adjust the display.  Simply uncheck the box you wish to change and enter the desired value.
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